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MBI-300

TNDIVIDUALIZATION OF DNA SOURCES BY STR ANALYSIS

1.0 BACKGROUND:

Once a DNA source has been detected, and identified as to
'source type' where applicable and feasible, itqg often
important to attribute the DNA sample to a piigbcular
individual inasmuch as possible. Current DNA™technology, in
the analysis of STR loci, offers individu ation potential.
However, the individualization of a paruipular sample occurs
through a comparative process. This q§cess requires a DNA
profile from a ‘known’ sample to wh ev1dence sample
profile can be evaluated. Often (gh ‘known'’ sample
is identified through a search cﬁ% <%§é (either SDIS, or
NDIS) database in cases where pgg e or of the
particular crime is orlglnal §§> NA samples are
collected from individual qualifying crimes
under Idaho code and areqz en al Z at STR loci for entry
into and subsequent se éﬁgBSt the DNA database.

"0

2.0 SCOPE: “fz/

To provide un <Z@'of DNA samples to achieve high

quality data% @’s éé:\ii interpretation.

3.0 EQUIPMEM}\BEAGE LEL)

As l€§%ed in individual analytical procedures.

4.0 Pﬁ%CEDURE:

See Flow Chart on following page.

Revision 10
Database Analytical Methods: MBI-300 11/29/190

Page 1 of 68 Issuing Autherity: Quality Manager




L

RECEIPT & DOCUMENTATION OF
DATABASE SAMPLE

h

BI~318

N
CAPILLARY ELECTROPHORESI&&(>‘4.

EXTRACTION P
BI<312 h
A
QUANTIFICATION A S
BI~314 <O
O
l q
\ %)
AMPLIFICATION J ‘E)
BI=316 h QSSJ

Q

h 4

ACCEPTAEBLE

Q

r>§§arf£§bf;<zﬁ

ACCQ@%EﬁL;é:}

%

5.0 COMMENTS:

SN
KR =g
REVIEW & ENTRY INTO

2
@Q

(§§:535chTABLE

’ﬁggfl. Qb &
NOT ﬁ@éﬁ%gﬁ@hf{;igggL_f———
et
GENEMAP D ANBEYST

</

.

CODIS BI-302

5.1 Careful scrutiny at each step will ensure insufficiencies
are identified, and compensated for where feasible, at the
ecarliest possible point (see BI-318 for specifics).
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. BI-301

CODIS SAMPLE RECEIPT AND DNA TRACKER ENTRY

1.0 BACKGROQUND:

The implementation of the Combined DNA Index System (CODIS)
in forensic DNA laboratories has provided an ad Grional tool
in assisting law enforcement agencies in solvqﬁg’or linking
crimes that otherwise may not have resulted Y the
identification of a suspect. It is impo &ht; however, that
samples entered into the database be giyer’a unique
identifier, which does not include ai§§$érsonal or
identifying information, in order t intain the
confidentiality of the 1nd1v1dual aT@.ac aboratory must
develop a method of identifier <§ Cgéh o that each
sample may be tracked and 1den€3 ater time, 1f the

need arises.
@ @

Idahe Statutes: Title 19 zgg R;) cedure, Chapter 55
“The Idaho DNA Databa%%>,c ®]

ISP Forensic Blolo ){ <§%edure Manual, Appendix C

2.0 SCOPE: e?}

To provide <§m $;§b § (;%acking offender database samples

submitte or S ng and CODIS entry, while ensuring
individ%éi confide lity.

Egﬁigﬁgum/REAGENTs:

Computer Workstation with ISP Intranet Access
Barcode Equipment

Court Orders, Database Samples, and Report Forms

4.0 PRCCEDURE:

4.1 SAMPLE RECEIPT:

4.1.1 Offender DNA samples and their corresponding DNA
Collection Report Forms received by the

Revision 10
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laboratory are to be marked with the date of
receipt and the initials of the scientist who
received them. The sample and report form may be
mailed to the laboratory separately; in the event
that a sample has not been received, the
submitting agency should be notified.

Where possible, compare the DNA sample card
information to that of the Collection Report Form
to ensure accuracy. Data for a sampi%bmay be
entered in absence of a DNA Collecthg Report
form. Additionally, an IDOC# is notZnecessary
for data entry into DNA Tracker, LUt it is
preferred. Contact necessary qg%b personnel or
search the corrections webs;K@
(www.corrections.state.id. gﬁg for a number 1f one
has not been recorded. Collection Report
Form will be retalned erc§§ Tracker data

entry.

The offense list@ n g:@sample card and/or
Collection Rep mu gualifying cifense
under ITdaho Cege Q; 50€;ﬁn order for the sample
to be ente inko racker and subseguently
CODIS/ND ctions website listed
above, ;géﬁep051tory, and/or ILETS will
lt re information 1f the offense
té;b llfylng or unclear. The
iéb 2:% , in good faith, on the
1 fo %?%rov1ded by the submitting agency for
ntry 1 Tracker It is not necessary, hor is
it the sc1entlst's responsibility, to verify the
offense(s) of every Offender if the information
provided by the submitting agency qualifies as
listed. The ISP Attorney General’s Office will
be consulted on a case by case basis regarding
the release of information if a non-gualifying
offender is involved in a candidate match.

Samples received in the laboratory that do not
have an associated qualifying offense will not be
entered into DNA Tracker. The collecticon report
(1f present) will be marked to indicate that the
sample is a non-qualifying offense and returned

301
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4.2 COURT

to the submitting agency. If there is no
collection report, a copy of the sample card will
be made, marked in the same manner, and returned
to the submitting agency. The sample(s) will
then be destroyed.

ORDER RECEIPT:

4

4

L2

L2

.1

.2.2

Court order forms received by the laboratory are
to be marked with the date of receip %nd the
initials of the scientist who rec?§g§d them.

The offense listed on the Cour @rder must be a
qualifying offense under Ida ode 19-5506 in
order for the court order Légérmation to be
entered into DNA Tracker§§>

If the offense on the ziisg is not a

qualifying offense,qgo £ ctlon will be

taken. The cour Qﬁ11 marked to
indicate it 1s CEOn Q}al ing offense and
returned to t agency.

4.3 DNA TRACKER PB.E.%N’&&@S)@__

\V o\
4.3.1 Prz?ﬁ?& <f%t ry for any new sample or court
() ‘se search is performed to
&Dim] licate offender entry. Log on to
x3¥he D cker database program, located under

o

Forensics”’ on the ISP Intranet.

<2($23.2 A duplicate offender search will be performed

CODIS Methods:

Page 5 of 68

3.

using the ‘Name’ field, followed by at least one
of the ‘ID’ fields to maximize the potential for
locating an offender. Note: the ‘DOB’ field may
only be searched in combination with a name.

If all of the searches return ‘No matches found’,
the data for the new sample or court order may be
entered as a ‘New Offender’ (see 4.4).

BI-301
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4.3.4 If a record(s) is returned that meets the

criteria, the data is examined and compared with
the new sample or court order received. If it is
determined that the Offender already exists in
DNA Tracker, the new sample or court order and
any additional Offender information will be
entered under the appropriate tabs for the
already existing Offender. Each sample received
for an offender will be assigned a unique barcode
number and will be retained in the laboratory
(see 4.4). 1%

Ny

4.4 DNA TRACKER ENTRY: %Q

4.4.1 Enter basic Offender infor ‘cgon from the court

Q‘OQ

4.4,

CODIS Methods:
Page 6 of 68

order, sample card, and/%g?DNA Collection Report

form as follows: <Q
O

1) For Offenders noﬂZpur é;% Tracker, click
‘New Offender’ &' t?éb 0 he screen and
fill in eac riate fields with the
Offender’s ation. Additional
1nformat f ers already in Tracker
may be Q§> icking the ‘Edit Basic

Det i %ég;hat Offender.
23 aig, information is correct and

&§é {%{ * button in the top right corner

%%% ltzonal alias namesg, DOB’s, SSN’'s,
Identification Numbers on the

\.
K appro iate alias tab{s) that become available

after saving the new offender. Click the
‘Save’ button after each entry.

Enter each offense and its associated information
from the court order, sample card, and/or DNA
Collection Report form as follows:

1) Click the ‘Offenses’ tab for the saved
offender.

2} Choose the appropriate offense from the pull
down menu and enter the corresponding
information into the remaining fields.

BI-301
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3) Verify the information is correct and press the
‘Save’ button in the top right corner of the
window. Multiple offenses for the same
Of fender must be entered and saved
individually.

4) Offense information may be updated/edited if
additional data is received at a later time
{e.g. when a sample arrives, fulfilling a court
order or an additional sample for the same
offense is received). Under the ‘Offenses’
tab, click on the appropriate off code
listed in the table of offenses CEnter the
appropriate information and cli‘ the ‘Save’

button, qb

4.4.3 Enter Court Orders for an O@ﬁgnder as follows:

1}y Click the ‘Court Orqgrs (5% for the saved

ocffender.

2) Enter the court d recelved dates.
Note: the orde e will
automatical e the sample history,
once a sampde h n eceived fulfilling that

court or

3) Click Qg$>0f se’ link and choose the
appr ateNet e/court case from the pull
dow enu&, te: the offenses in the pull down
i a thes® previously entered in the

& fﬁé@ﬁegg;)ab. A court order must have an

Ox i offense in order to be entered;

{SS thereésg%, the offense information must be
entered prior to the court order.

C§Q 4) Verify the information is correct and click the
<2§ ‘Save’ button,
5) Once the court order has been entered it is

placed in the appropriate filing cabinet
located in the CODIS office.

4.4.4 Enter samples for an Offender and print sample
barcodes as follows:

1)Click on the ‘Samples’ tab for the saved
Offender.

CcoODIS Methods: BI-301
Page 7 of 68
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2)Enter the sample information into the
appropriate fields, leaving the barcode field
blank (Tracker will automatically generate a
unique barcode number if the field is not
filled in}.

3)If the submitting agency is not listed in the
agency pull down menu, it may be added by
clicking on the ‘edit agencies’ button to the
right of the agency field.

4) If the sample received is pursuant Lo a
previously entered court order, c €% on the
‘Show Unfulfilled Court Orders’ :Xbik. Click
the box next to the approprlat(' ourt order to
mark it as fulfilled by the@@hple being
entered.

5) Fnter the number of barc labels to be
printed. One label lS placed on the DNA
sample card/folder, mi%he collection
report, and one in ® d the FTA card
envelope for plaq@men FTA card at the
time of analys

6) Verify the m n correct and click the
‘Save’! but labels will
automati y ﬁx n on saving the sample

infor

7)Stap%§ Q&%& ectlon Report (if present)

the DNA sample folder and
oprlate barcode labels. The

<§§P Sample card, with collection
11 be placed in one of the filing
{SS located in the CODIS office.

8) Barc 1abels may be printed at a later time

C§Q for individual samples, by clicking on the
<2K appropriate sample from the ‘Samples’ tab or

for multiple samples, by using the ‘Batch
Samples’ function at the top of the screen.

CODIS Methods: BI-301
Page 8 of 68
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BI-302

CODIS SAMPLE DATA ENTRY AND UPLOAD

1.0 BACKGROUND:

in forensic DNA laboratories has prov1ded an -« itional tool
in assisting law enforcement agencies in so g or linking
crimes that otherwise may not have resul ﬁbln the
identification of a suspect. Accurate entry for upload
to NDIS (National DNA Index System) ‘gésentlal

The implementation of the Combined DNA Index Sygebm (CODIS)

It is the responsibility of the F clentist to
generate profiles from convicte ré§?;§pd/or forensic
samples, determine CODIS ellglgg_ w other
scientist’s profiles, enter\S§21r s into CODIS and

notify the CODIS Admlnlst@o
associated with their COC [b) P

The CODIS Manager

is responsible, in pa \g rv the laboratory’s chief
point of contact fo unications, maintain
CODIS software up éi?% Yity, update/add/remove CODIS
users, and uplo NDIS

DNA profile ég%er ‘C:(jP@ODIS will be done so according to
CODIS and Nés E§¥ @nal Procedures. Idaho currently
allows £ data Wiéz)lnto the following Indices: Offender
{convi QH offende Unidentified Human Remains (deduced
miss] person, unidentified person); Missing Persons

ed father/mother, biological child/father/mother,
si¥ling, deduced missing person, missing person,
maternal/paternal relative); Forensic Mixture; and Forensic
{known and unknown) . Profiles entered into the Forensic
Tndex include both solved and unsolved cases in which the
profile is associated with a crime and believed to be
attributable to the putative perpetrator. Suspect reference
samples and profiles matching the victim{s) and/or any

elimination samples {e.g. consensual partner samples) may
not be entered.

Revision 10
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et 2.0 SCOPE:

To provide a mechanism to ensure accurate data entry for all
offender and forensic database samples

3.0 EQUIPMENT/REAGENTS:

CODIS Computer Workstation

Allele Tables and/or CMF files generated from egaple

analyses. ~SS>
" S
CODIS Training Manual Qb
4.0 PROCEDURE: (\%\0
4.1 sSaMPLE DATA VERIFICATION: \Q Q*

4.1.1 Genotypic data (all@le GQSQS Y%ke checked for
accuracy and verified dori he CODIS/Casework

Rev1ew proces d d on the appropriate
form {Form: 3&? <§p 214=BT, respectively).
4,1.2 Forensic @?MJ@@l @erson/Unldentlfled Euman

profllee) re r%i%gd for CODIS eligibility and
Index QQ& ed on the CODIS entry form

&@
4.1.3 KB €£§2 when ‘STR Data Entry’ is used to
{S' nter i dual sample data (generally forensic
@) samples} verlflcatloﬂ of allele calls and
Q) specimen category is performed prior to an SDIS
\\ search and NDIS upload.

%

4.2 SAMPLE DATA ENTRY IN CODIS:

4,2.1 Once sample data accuracy {forensic and offender)
has been verified, data may be entered into the
CODLS database either by use of the 'S8TR Data
Entry' module to enter specimen ID/info and
allele calls for individual samples or by using
the 'Import' function for the entry of batches of
data contained in a .ocmf (or egquivalent) file.
Refer to the CODIS Training Manual and course
documentation for specific steps in accomplishing
these tasks.

Revision 10
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4.2.2 A second 'read' must also be entered for the

individual samples through 'STR Data Entry'

This may be done by the analyst entering the
sample data, or by another analyst logging on and
entering the allelic data in the second read box.
If a single individual enters both reads, the
entire profile (i.e. all loci) for the first read
must be entered prior to entering any data into
the second read. A 'check' indicates agreement
between readers at individual loci a
discrepancies in entry must be rect\ 1ed before

saving to SDIS.
g Qg‘

4.2.3 When using the 'Import' fun¢¥idh, the scientist
will open the appropriate {or eguivalent)
batch file select ‘wvalid ort! This will
ensure that any typos ?§\ ncqgglstenCLes (i.e.,
variant allele deflnl 1 lencies) will be
identified prior toQ@mp ay be corrected.
Once the batch fl <§%ee lidated for import
(corrections p §:§§Eessary), "import' is
selected by t i d the process of
importing t %S' (:p data into SDIS will
commence(ED

4.3 CODIS DATA &

Q‘OQ

CODIS Methods:
Page 11 of 68

.3,

2

£Bar S is to be performed to identify any
ote atches at the state level. This is
typlcall done by running the ‘Autosearcher’
function in the software. See BI-303 for
verification of any candidate matches identified
during the autosearch,.

4.3.1 i RS r &§Rpg ing eligible samples to NDIS, a
{\

There are various reasons that some samples
present at SDIS should not be uploaded Lo NDIS.
Prior to NDIS upload, these samples will be
selected in Specimen Manager and 'unmarked for
upload'. Generally speaking, an incremental
upload will be performed. 1In Specimen Manager,
"incremental upload' is checked on the 'upload'
pull-down menu and 'send upload' is selected.
The uplecad is sent to NDIS as a message
attachment wvia DNACOMM., If any 'candidate
matches' are identified at NDIS, a match message

Revision 10
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will appear in DNACOMM and they will also be
reflected in Match Manager. For hit verification
see BI-303.

5.0 COMMENTS:

5.1 Refer to CODIS Training Manual and course documentation
for more specifics if necessary.

5.2 The CODIS software is redundant and there is generally
more than one way to accomplish many tasstgbUsing a

-

mechanism other than that listed here igsgbceptable.

N
5.3 The CODIS software is updated periodi?ﬁ%ly and any
necessary changes in procedure proided with new
updates supercedes those in proc res written prior to
update, if appropriate. <gb

o) @
5.4 The sample history for conVﬁ@teq:§?
DNA Tracker will be updg&éﬂ tore
analysis (in progress, ~Gemp
appropriate), date s Sl S ourced for testing,
and/or date profi qzwasﬁgﬁtexéb into CODIS. This is
accomplished fo ividua (:hmples under the ‘Samples’
tab for the Offey e§8§§ filking on the appropriate
sample and cheysiné}sA istory Event’. Multiple
samples maysgé t sing the ‘Batch Samples’
function &} theyto the screen. The current
disposi §Bn @%gg be checked as appropriate for the

histo s) d
I
5.5 E ible forensic profiles of unknown origin (i.e.
<§§éiiles not matching any of the known reference
<2 samples) identified in the course of casework analysis
must first be compared against the ‘staff’ index before
entering the profile into the database. The ‘searcher’
function is used by hand entering the profile and
choosing the ‘staff’ index. This profile will not be
saved upon completion of the search and will need to be
entered as outlined above for storage in the database.

er samples in
dates of sample

4

5.6 ‘Searcher’ is also used for performing one~time
keyboard searches of forensic unknown profiles. A one-
time search will only be performed under exigent
circumstances and only on single source samples with a
minimum of 8 loci present. The DNA profile must have
been generated by or on behalf of a criminal justice

Revision 10
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T
i

agency, by an accredited laboratory, in compliance with
the FBI Director’s Quality Assurance Standards (QAS},
and must be maintained by a Federal, State, or Local
NDIS participating laboratory. Additionally, requests
for one-time searches of non-ISPFS profiles must be
received from the CODIS Administrator of the laboratory
that maintains the profile. When performing a one-time
search, the requesting agency will be notified either
verbally, or in writing in the event of a negative
search result. See BI-303 for verification .of
candidate matches identified during the pefggime
search.

e

&
S %
.\\()@ N Q/é
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SCOPE:

BI-303

CODIS DATABASE HIT VERIFICATION

1.0 BACKGROUND:

The implementation of the Combined DNA Index System (CODIS)
in forensic DNA laboratories has provided an additional tool
in assisting law enforcement agencies in solving or linking
crimes that otherwise may not have resulted in tée
identification of a suspect. This is accompli@ited by the
electronic storage and maintenance of DNA p iles at the

iocal, state and national levels. Hits & obtained when a
candidate match(es) is identified throu h~a database search
at any level. Hit verification invol evaluating the

candidate match to determine if it é§>a rue match and
verification of CODIS offender sae§' Q@ where necessary
O

and possible. Q C) &
2 >
NDIS CODIS Hit Disposition %&brt@ g%nfirm an Interstate

Candidate Match - Operati %g‘ e g
> O

@ O
3¢ 003

To provide a metho Cé% §$§8 <%;§%ification to be performed
prior to law enf m agendy notification of a database
X .
hit to ensure eébori§hg QV’ nly true, confirmed matches.
N 00O
EQUIPMENT / Gm@s:%?
NS
SRS
CODIS %2)
NDI ‘@?ocedure Manual; CODIS Training Manual/documentation

Dﬁﬁbracker
AN S

Offender Database Sample({s)
Equipment/Reagents for STR Analysis

PROCEDURE :

4.1 MATCH VERIFICATION (Forensig):

4.1.1 For 'hits'/matches involving an ISP Forensic
Biology evidentiary sample (either case-to-case
or case-to-offender and including one-time
keyboard searches) the primary responsibility for

Revision 10
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match verification follow-up and disposition lies
with the Idaho CODIS Administrator.

4.1.2 The CODIS Administrator or designee (typically
the case analyst) will first evaluate the
'Candidate Match' in Match Manager to determine
if there is a basis for exclusion and, therefore,
disposition as 'No Match'. A 'No Match'
disposition doesn't requlre further verification
or, where applicable, notification of the other
laboratory involved with the match. <

be
4.1.3 If evaluation in Match Manager de@énstrates that
the candidate match consists tential high

stringency (e.g., exclusions @&t ributable to
different typing systems, P@}mega v. Applied
Biosystems), or possibly erate stringency in
the event of a foren51%§m xt \g or degraded
sample, the dispositi d from

'Candidate Match' EQ@'P@QL n ntil the

verification pro om e. In general,
for case-to-ca Ghat §> verification will
consist of CO&;an tween scientists

da aAvan ase status, while case-

regarding tair
to-offen S<E>pically necessitate sample
verlflceg oné;t "offender lab'.

4.1.4 f} f the 'candidate match' has been
vs\ﬂ) %&Lsposltlon is set accordingly
tch', 'Offender Hit', 'Forensic
xS&utﬂ Q§§¢H6tlon Match’, ‘Investigative
Informat¥on’, etc.} and ‘Investigations Aided’
c) filled in as appropriate and as outlined in the
<2§ NDIS ‘CODIS Hit Disposition Reporting’ procedure.
4.1.5 If verification results in a 'hit', a hit report
is issued by the case analyst. A copy of the hit
report, along with the CODIS match report, is
filed in the CODIS file. The original hit report
and a copy of the CODIS match report are placed
in the associated case file. The appropriate law
enforcement agency is notified of the 'hit'. If
the law enforcement agency submits a sample from
the identified offender, appropriate analysis and
issuance of a supplemental report will be
performed as in 4.2.5.
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4.2 MATCH VERIFICATION (Offender):

4.2.1 For 'hits'/matches involving an ISP Forensic
Biology convicted offender sample the primary
responsibility for match verification follow-up
lies with the CODIS Administrator for the
laboratory with the forensic (evident Ary)
sample. However, the initial evalua JC-Bn in Match
Manager (see 4.1.2-4) and AFIS sa
verification (see 4.2.2) will be { itiated as
soon as feasible once a verif] ion request has
been received from the foren§5c laboratory.

4.2.2 Once a potential match h confirmed and a
verification request the assoclated
offender sample fold {% trleVed from the
secure file cabine and BCI or the
latent flngerpran~ (f? an AFIS search of

i, Fy ntification of the

the thumbprint<§ v
offender. A

nt@ﬁ on will be filed in the
CODIS file

@6 0

4.2.3 Follow1 é§b ﬁi&}lcatlcn of the thumbprint,
re- azé?ySL Qo offender sample will be
pe{} opriate (i.e., if duplicate

r

eady been performed either as a

t r as the result of a duplicate
{SAsample, lysis will not be repeated) prior to
agency notification. 1In situations where a

c§Q thumbprint was not received with the DNA sample,

< or is of insufficient quality for verification, a
notation will be made and re-analysis for
confirmation may proceed. The forensic
laboratory (or law enforcement agency for Idaho
cases) will be notified that the Offender could
not be verified through thumbprint confirmation.

%

4.2.4 Following sample verification (AFIS and re-
analysis as appropriate) the forensic case
laboratory, in the case of an interstate hit, or
submitting law enforcement agency will be
notified of the confirmed hit. Laboratory
notification may be made verbally and relevant
documentation will be provided to the forensic
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case laboratory as requested. In Idaho, initial
notification as well as the request for a new DNA
sample from the identified offender, may be made
verbally. However, written notification and a
formal request for a new DNA sample, in the form
of a hit report, will be sent to the appropriate
law enforcement agency.

4.2.5 For intrastate offender hits, where possible, a
newly obtained DNA sample from the offender will
be analyzed with all deliberate speeqb The
analysis of the forensic sample ma (3lso be
repeated, though this is not re ed. A
supplemental report will be ia%;gg delineating
the match in the usual manney, {3.e., same

treatment as for matching sé%pect sample
submitted with case evidgéaé);\

et
4.2.6 The sample history iﬁ%égA(zgz will be updated

to reflect the da:c%)@he e Q/ confirmed for the
offender sample. \N QQ @
AN
5.0 COMMENTS: N O
E— @ O
5.1 A good faith e ﬁ§>made to resolve matches

"@Q
within 30 bustsessé§éy§;%yom the date of the match or
e 1.

from the da of i fication request for interstat
m;tchesej\@&jé&&aho gffe?lde];.q ’ ©
& oo
N VR
& O
Q®
)
Qﬁ
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BI-310

CODIS SAMPLE REMOVAL

1.0 BACKGROUND:

participation in the National DNA database, in accordance with
the DNA Analysis Backlog Elimination Act of 2000, Scessitates
provisions for DNA profile expungement in the e that a
qualifying offender’s conviction is overturned{ Additionally,
the Idaho DNA Database Act of 1996 addresse urt-granted
expungement requests (I.C. §19-5513). Remeval of DNA profile
data and/or destruction of biological saq§~es obtained from
Convicted Offenders may be necessary result of conviction
reversal or sample collection/submia§$on qé;brs.

<~ &
Expungement is defined as the re alxo rofile data from
local (LDIS), state (SDIS) and\m ti@l s) databases in
response to a court order o £Qu£$én @ offender’s conviction
of a qualifying offense. Kgunqé n(;§§ll include the removal of

r

identifying information m 8£ oratory documentation and
=2

destruction of the biq%égl m§>e from which the offender
database DNA profile aas qgker .

\
Administrative eq§§2ic§$? Yhed as the destruction of a DNA
sample and remdg§ n (:bcords relating to that sample.
Examples for Wbic mj qétrative removal may be warranted
include, butlare not @@ited to, the collection of a sample from
a non-qu I;fying offeider, or the notification by the collection
agency t removal is warranted. Generally, the determination
that e sample does not qualify for inclusion in the database
occurg prior to entry of the profile into DNA Tracker and
subsequently CODIS (see BI=301); however, there may be instances
when the collection agency provides notification of an error
after the profile has been generated. 1In these clrcumstances,
the profile will be removed from the local, state, and national
databases as part of the administrative removal.

NDIS Expunge a DNA Profile - Operational Procedures

Idaho Statutes: Title 19, Criminal Procedure, Chapter 55 "“The
Idaho DNA Database Act of 1996”
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P

S 2.0 SCOPE:

To provide a protocol for CODIS sample expungement and
administrative removal that protects an individual’s rights to
privacy and maintains the integrity of the Idaho DNA database

program. All procedures will be documented on the CODIS Sample
Removal Checklist {(Form 310-BT).

3.0 EQUIPMENT/REAGENTS:

ng
CODIS Workstation a{b
DNA Tracker Database '(A
%Q
4.0 PROCEDURE: )
o
4.1 EXPUNGEMENT Q
@ N
Q source

Prior to removal of any DNA p@glg

identificaticn, or blologl Qbsa

ruction, the CODIS

Administrator or designee 1 Il the request for
expungement is accompa <a ce fied court order that
meets the requirement d ig@I.Cc. §19-5513, 2) that
the offender has n0q§§g 1(8Ying offense(s) and 3) the
identification of 1m<> DNA database sample where
possible.
4.1.1 A se cker is performed to establish
whekﬁ r he specified sample has been recelved
ry and if so, whether or not a DNA

\. oflle h(B een generated and/or entered into CODIS.

4(§Q2 If the sample has been received in the laboratory, a
ecriminal history check in ILETS will be performed to
ensure that the offense for which the expungement is
requested is the only qualifying offense. If the
offender has a separate gualifying offense, the sample
will not be expunged and a copy of the criminal
history check will be retained for documentation.

4.1.3 The associated offender sample folder will be
retrieved from the secure file cabinet and taken to
BCI for an AFIS search of the thumbprint to verify
identification of the offender. The absence of a
thumbprint or a poor quality thumbprint does not
preclude the sample expungement from proceeding.

Revision 10
CODIS Methods : BI-310 11/29/10

Page 19 of 68 Issuing Authority: Quality Manager




4.1.4 The offender record will be removed from DNA Tracker
and a sample removal report generated.

4.1.5 The DNA profile, if applicable, will be deleted from
CODIS, followed by an upload to NDIS for removal at
that level. A written notification of the expungement
will be made to the NDIS Custodian and a request for
verification of deletion at the national level.

4.1.6 The original DNA Collection Report received with the
sample (or a copy of the sample folder en no report
is received) will be marked expunge Calong with the
scientist’s initials and date of exgghgement

4.1.7 The DNA sample will be destroygg and witnessed by a
second scientist.

4.1,8 Administrative paperworkcéocumﬁz%lng the event will be
retained in the CODIS g? perwork may contain

some administrative t§§or out the
<2?ed from and will
r

sample/individual
include the foll r1cable: the court
order/request r ex€§S? , criminal history check

and thumbpri n, DNA Tracker sample
removal re @[ letlon report (s), NDIS
correspon Rg samplie removal checklist, and

coplesﬁa& ondence with the requesting
part a>

4.1.9A (prQE§> notification letter (or letter
dicatin y expungement did not occur), the DNA
Q§tollectlon report or folder copy, and a copy of the
CODIS sample removal checklist will be sent to the

<2§ requesting party.

4.2 ADMINSTRATIVE REMOVAL

Prior to removal of any DNA profile data, source
identification, or biological sample destruction, the CODIS
Administrator or designee will verify: 1) the request for
administrative removal is in writing from the collecting
agency and includes a description of the error resulting in
the removal request and 2) that the offender has no other
qualifying offense({s).

Removal resulting from an entry error on the part of ISP
Forensic Bioleogy staff does not require a written request;
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although, the nature of the error should be documented.
Requests for administrative removal from a party other than
the collecting agency or due to biology staff error will be
referred to ISP legal staff for a determination of the
appropriate action to be taken.

4.2.1 A search of DNA Tracker is performed to establish
whether or not the specified sample has been received
in the laboratory and if so, whether or not a DNA
profile has been generated and/cr entered into CODIS.

4,2.2 If the sample has been received in t laboratory, a
criminal history check in ILETS wik\ e performed to
ensure that the offense for whi he administrative
removal is requested is the on qualifying offense.

If the Offender has a separaué}quallfylng offense, the
sample will not be removed copy of the criminal
history check will be retéa dé?sr documentation.

4.2.3 The offender record wzﬂ CQ‘ d from DNA Tracker
and a sample remov rated.

4.2.4 The DNA profi le, will be deleted from
CODIS, followéé?% Qgpad to NDIS for removal at
that levelqb

4.2.5 The orl <Ral ‘<%;ction Report received with the
sampl co the sample folder when no report
is E%Sg§,be marked expunged, along with the
sc(}nt{B tials and date of removal.

4, 2(§$The DNA ;ggple will be destroyed and witnessed by a
C§Q second scientist.

<24.2.7 Administrative paperwork documenting the event will
be retained in the CODIS file. The paperwork may
contain some administrative information about the
sample/individual it was collected from and will
include the following, as applicable: the request for
administrative removal, criminal history check, DNA
Tracker sample removal report, CODIS deletion
report (s), CODIS sample removal checklist, and copies
of any correspondence with the collection agency.

4.2.8 A sample removal notification letter (or letter
indicating why removal did not occur), the DNA
collection report or folder copy, and a copy of the
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CODIS sample removal checklist will be sent to the
requesting party, or submitting agency in the event of
an internal entry error,

5.0 COMMENTS :

5.1 An Offender cannot be deleted from DNA Tracker if there are
any samples and/or court orders assoclated with the offender.

5.2 A sample cannot be expunged or deleted from D Orracker if
there are qualifying offenses associated w%&§b he Offender.

X
5.3 The ‘Delete Sample’ function will be usg@?&o remove a sample
from DNA Tracker for an Administratiuecﬁ moval.
2
5.4 The ‘Expunge Sampie’ function wilbé%e

Eﬁed to remove a sample
from DNA Tracker for an Expun%§%§n

Q

O

. Q® \O Q/é&
N

Q
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BI-312

EXTRACTION PROTOCOLS FOR PCR DNA TYPING TESTS

1.0 BACKGROUND:

3.0

Many methods exist to obtain DNA, suitable for amplification,
from a variety of sources., It has become increasingly important
to streamline the extraction process through automation. A
variety of extraction methods and robotics system ve become
available for the successful extraction and dow ream processing
of known database DNA samples, using both blo and buccal
collection methods. The Promega DNA IO Exté?@%ion System and the
Beckman Coulter Biomek 3000 robotic workstatTon are both examplies
of systems that have proven successful %ﬁb he forensic community.
Comey, CT et al. “DNA Extraction St?.@eg@ for Amplified
Fragment Length Polymorphism Analyﬁ@ .t:fb‘géQ Sci, Voi. 39,

1994, . 1254-1269.
pp ’\\C)@ Q\' Q/
Mclaren, B et al. “Automati (Qhqu§%,$§§gystem on the Biomek
3000 Laboratory Automation lzgrk iQE) Profiles in DNA, 2006
Vol. 9(1): 11-13 ,5\. 6\ O
o O
“High=T

Tereba, A et al. Processing of Samples on Solid
Supports Using the‘ﬂ§§c evice.” Profiles in DNA, 2005
Vol. 8(2): 3-5. &0 O(\ N

N 90

DNA IQ System4ﬁth@§;b<€$atocol, Technical Bulletin (revision
date 4/06) ,{(‘Ex;omega. O

Automat DNA IQ System Protocol for the Beckman Coulter Biomek
3000<2ﬁechnical Bulletin (revision 6/09), Promega.

SCOPE.:

To provide appropriate protocols for the extraction of database
sample DNA, both manual and automated, suitable for PCR
amplification and subsequent analyses.

EQUIPMENT :

Pipettes and tips
Harris Punch
BSD600-Duet Semi-Automated Sample Punch Instrument w/ Scanner
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96-well Reaction Plate

MicroAmp Tubes

1.5m¢ microcentrifuge Tubes (1.5m¢ tubes)

65°C Oven

SlicPrep Device

Adhesive Foil Seal

70°C Water Bath

Centrifuge with Swinging Plate Rotor

Biomek 3000 Robotics System with MagnaBot 96 Magnetic Separation
Device, 1/4 Inch Foam Spacer, Variomag Telesha&éb and Heating

Block . \SS)
Reagent Reservolrs «
2.2m¢ Square-Well, Deep Well Plate qga
1.2 m¢ Round-Well, Deep Well Plate O
'\
4.0 REAGENTS: Q(\
\ Q*

FTA Purification Reagent % &

PCR TE (TE, 10mM Tris-HCLl; O. 1mM@ %0

DNA IQ System Reagents

99% Isopropyl Alcohol QO 0@

95-100% Ethanol

1M Dithiothreitol (DTT) \Q

L,
5.0 DNA EXTRACTION PROCED,Q%S Q/
S ‘
5.1 FTA EXTRACTIOE> O%D ATABASE SAMPLES:
Note: Slnc<§fh alns bound to the FTA card, regular,
fll tte tips may be used throughout and a
gle tlp be used for each reagent. A multi-

(%hannel pipettor and 96-well reaction plate may be used

<2<$> for larger sample batches.

5.1.1 Remove 1-3 “punches" from the FTA card using a 1.Z2mm
Harris punch (this is accomplished by placing punch
firmly on card and twisting 1/2 turn clockwise and 1/2
turn counterclockwise). Eject/punch sample(s) into
microAmp tube(s)/plate. Alternatively, the BSD puncher
may be used to punch 1 2mm punch directly into the
plate (see 5.2.1).

5.1.2 Add 150p¢ FTA reagent to microAmp tube(s)/plate, gently
mix and incubate at RT for ~5 minutes.

5.1.3 Remove and discard FTA reagent from sample(s).
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Repeat 5.1.2-5.1.3 twice.

Add 150pt¢ TE to microamp tube(s)/plate, gently mix and
incubate at RT for ~5 minutes.

Remove and discard TE from sample(s).

Repeat 5.1.5-5.1.6 twice.

Make sure the punch is at the bottom of microAmp
tube (s)/plate, using a sterile pipett Gip if
necessary. Place tubes/plate, uncov d in 65°C oven
for 22 hours,

5.1.9 Proceed to PCR Amplification éﬁ%&’BE—BIG).

5.2 AUTOMATED DNA IQ EXTRACTION ETKX%§83DIQ§£EHHKBASE SAMPLES

5.2,

SAMPIE PUNCHING USING@HE QQ% UET

5.2.1.,1 Fill ounghe%2§§> I Load Sheet on the
‘BSD <§$§ of the batabase
Form 312=BI). Print a
tch record. Choose the 'BSD
uté§§? ab and ensure the information is
Ys;gr corresponds to the Load Sheet
e> n entered. Delete any unused

aklng sure to keep ‘End File’ as the
\:> ell. Perform a ‘Save As’ of the

{SS sheet to disc (e.g. USB drive) for

%4 sequent transfer to the BSD600 puncher.
C§Q The document must be saved as a .txt file.
< Save the template as samples are

%

automatically populated on the other tabs for
subsequent processing steps.

Note: The last two columns of the plate
should be left empty for control placement in
subsequent steps. This allows for 78
samples, an extraction control, and a reagent
blank to be tested per plate.

5.2.1.2 Ensure the BSD tray table is adjusted
properly by placing the appropriate plates in
both positions and adjusting the height, as
necessary. The bottom of the chute should be
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~2mm from the top of the plates, measured at
each corner.

5.2.1.3 Turn on the BSD puncher and computer and plug

5.2.1.4

5.2.1.5

in the air/pressure pump. Make sure water
is present in both filter bottles (~50-
100ml). Double click the ‘BSD Duet Main
Menu’ icon and login using the appropriate
user name and password.

Choose Configure System and o the Files
tab. Ensure that File Input Qs selected from
the Sample Number Mode dr own list., Click
the Browse button and te your saved
input file to fill in,the Input File Name
box. Click Save an@b xit.

Note: Using the 1e option only
allows for a tﬁkto be punched at a
time. To puqy plates, the process

must be r &ch new set of

samples () \
R \Q)

Choo %@% ib Spots and click Continue.
o select test group to punch,

Available Tests and click
nQ& eck the box next to Input

nd check the samples box on the
Press Continue. This test file will

\:§$ 3 of the 3.2mm spots (verify before
{Ss Eégznnlng) T£ punching for FTA extraction,

&S

5.2.1.6

5.2.1.7

Database Analytical Methods
Page 26 of 68

e number and size of punches will need to
be changed under the Edit Test Sequences
option prior to beginning.

Place the appropriate plate into position 1
of the BSD tray table with well Al located
in the upper left cornexr. Click Continue to
begin punching. When using the SlicPrep 96
Device, remove the white collar, push the
basket down into the plate, and set the
collar aside before processing.

Scan the sample barcode using the scanner
attached to the BSD and place the card under
the card clamps on top of the instrument.
Use the light guide dots to properly position
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the card for punching. Press the foot switch
when ready to punch or use the delay switch
for automatic punching. Repeat until all
samples have been punched,

Note: The scanned barcode must match that on
the input file or the instrument will not
punch the card.

5.2.1.8 Remove the plate and proceed to.SlicPrep pre-
processing (see 5.2.2) or FTA traction (see

5.1) . A\
5.2.2 SLICPREP PRE-PROCESSING ng

5.2.2.1 Add 400ul DNA IQ Ly Q_;} Buffer with DTT (see
5.2.3.1) to each the device plate.
Seal the top o with a foil seal
and place lnto bath for 15-60
min. éé;

5.2.2.2 Without QAOV §\3%011 raise the filter
basket R?hce(lhe white collar back onto
the Yy ding it under the basket and
alqgh Qg% ents on the device.
O

5.2.2.3Cen S? he device at 1500 x g for 5 min.
\§§>in iﬁiggﬁng plate rotor. Remove and
X e the collar and filter basket upon
O 0 or&tion of centrifugation.
SRS

Qgs 2.2.4 Proceed to DNA IQ Extraction on the Biomek

{$§Q 3000 {see 5.2.4).

.3 DNA IQ REAGENT PREPARATION

5.2.3.1 When opening a new DNA IQ kit, add 1.5ml 1M
DTT to the bottle of Lysis Buffer (lul
DTT/100ul lysis buffer) and mix. Mark the
bottle with initials and the date the DIT was
added. The ‘activated’ Lysis buffer may be
used for up to 2 months following DIT
addition. Alternatively, the lysis buffer
may be prepared as needed based on the number
of samples to be processed.
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5.2.3.2 Prepare the new wash buffer {(70ml 2X bottle)
by diluting with 35ml Isopropyl Alcohol and
35ml Ethanol for a final 1X concentration.
Mark the bottle with initials and the date of
alcohol addition. The 1X wash buffer may be
used for a period of 1 month after
‘activation’. Alternatively, the wash buffer
may be prepared as needed based on the number
of samples to be processed.

5.2.3.3 Prepare/aliquot each of the D IQ reagents
at the time of use, based o (#he following
calculations and reservoir(positions
(instructions listed in g&:‘Reagents for
Solid Support’ commean window) :

i: Elution Buffer:é§ﬁ.2 1 + {#samples x

100ul) {Q

Z2; Empty Q O &

3: 1X Wash fer (:& + (fisamples x
G.3ml)

4 Ly31 ff ‘<;4:§§% = 1.5ml1 + {f#samples x
0.

. 5: Lydis é 0 DTT + Resin = {860ul +
Lo @43u1)1y5151 + [140u1 +

=
(#%I%}é/x 7ul) resin}
‘(ﬁg B@o y'{(/
5.2. DNAS\E\Q B f& \/USING THE BIOMEK 3000 ROBOTICS

" Q

S
Q§5 2.4.1 Turn on the Biomek 3000, computer, and Watlow
@) heater. Make sure that the heater is set to
<2§» 85°C and that the shaker electrical box dial
is turned to the red at the far left stop.
5.2.4.2 Check the teleshaker connection by choosing
start > programs > teleshaker v.1.2. In the
test program window, choose options >
interface > com 2 and click Ok. Select file
> connect.

5.2.4.3 Open the Biomek Software and choose the ‘All
Others Method’.
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5.2.4.4

Set up the Biomek 3000 deck as follows
(cutlined in the ‘Tools & Labware for Solid
Support Method’ comments window):

Rack 1 (Al): Tool rack with MP20C (1)and
gripper (3)

MLl (AZ2): P250 barrier pipette tips

ML2 {(A3): P250 and/or Axygen 165ul barrier
pipette tips (up to 48 samples)

ML3 (Ad}: P250 and/or Axygen 165ul barrier
pipette tips (up to samples)

ML4 (A5): P250 and/or Axyge (1%5ul barrier
pipette tips (%E$ o 96 samples)

P6 (A6): Heating syste

P1 (Bl): PCR plate amqbbase

P2 (B2): empty

P3 (B3) Reserv01zg%ka and reservoirs with

reage
P4 (B4): Pre Z@Ce p square-well plate
P5 (B5}: rou plate stacked on the

B BGQ 3:1@1 @shaker

Not\éS?%Q§;§tm of tip boxes will depend on
amples to be extracted. The
K@ll only extract full columns on

If using the Axygen tips, do not

ety
\6&%’(\}1@%/%8 the first box (ML1).

5.2.4.6

5.2.4.7

Database Analytical Methods
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%\ {t§él<§%)the green run instrument arrow button
g

egin the run. When prompted, enter the
ber of columns to be extracted, choose 0
for solid support method, and either 50ul, or
100ul for elution volume. The 50ul volume
may be preferable for lower concentration
samples. Verify the reagent and deck layout
and click ok.

When the run has finished remove and seal the
PCR/elution plate. Discard the deep-well
plates, remaining buffer, and pipette tips.
Clean the reservoirs between runs.

At the completion of all runs for the day,
wipe down the deck with 10% bleach or
Dispatch solution. Tools may also be cleaned
with 70% Fthanol i1f necessary.
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5.2.4.8 Proceed to realtime PCR (BI-314) for
quantification of the purified DNA obtained
in 5.2.4.6.

6.0 DNA EXTRACTS:

6.1

After a plate of samples has been extracted and during
subsequent analyses (e.d. gquantification and amplification),
the DNA extracts may be stored sealed with foil at 4°C, For
longer storage periods, the extracts should bquéozen at
approximately —-20°C. These extracts are in:&ébgress work
product during this stage(s). Qé‘

Any extract remaining, following the s Fessful completion of
analysis and data review, will be dl&é}fded

Qﬁ

7.0 Comments:

7.1 A reagent blank shall be c all extraction steps
to check the purity of t ing used. There need
only be one reagent bl ion plate, but the
analyst may choose tcn§§? Ei lt(:pal blanks on a given plate.

7.2 These procedures 6;3 @ms@or bleood or buccal samples on
FTA paper. \(\ Q/

7.3 The DNA IQ g§1n<§b %2> thoroughly mixed/resuspended prior to
allquotlio 0

7.4 The figa elution(;%lume attained on the Biomek 3000 will be
~8iK less than the volume chosen, due to evaporation during
t{? processing.

7.5 The Biomek 3000 performance verification color plate (Eorm
428+BI) is run by choosing the ‘Color Plate/Performance Check'’
method in the Biomek Software. Deck set up and dye
preparation is described in the ‘Instrument Setup’ step and
the ‘Deck Setup Instructions’ comment window.

7.6 The DNA IQ extraction procedure may be performed manually, if
necessary, following the procedure outlined in the DNA IQ
System-Database Protocol, Technical Bulletin (revision date
4/06) This procedure follows the same steps as performed on
the Biomek 3000.
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BI-314

DNA QUANTIFICATION: REAL-TIME PCR

1.0 BACKGROUND:

DNA methodologies that employ the PCR, such as STRAébealysis,
necessitate consistent quantification of human DNRD o obtain
optimum data. A\

N

"pDevelopmental Validation of the Quantifiler al-Time PCR Kits
for the Quantification of Human Nuclear DNP(JSamples," Green, R.L.,
et al, Journal of Forensic Science, Vol , No. 4, pp. 809-825.

“Improving Efficiency of a Small Fo Laboratory
Validation of Robotic Assays and E\élua Mlcrocaplllary Array
Device,” Crouse, C., et al, Croai;.@ed Vol 46, No. 4, pp.

563-577. (Q @

Quantifiler™ Kits (Quanti ’@16 \Hé@ DNA Quantification Kit and
Quantifiler™ Y Human Ma@ DN@} fication Kit) User’s Manual,

Applied Biosystems. \
0 O
7500/7500 Fast R%(b. Ti %C@ystems Maintenance -Guide, Applied
Biosystems. 5\
2.0 SCOPE: \:j$>
oo oy VP

To provi a reliable method for the consistent quantification of
Varl$® mounts of human DNA isolated from database samples.

3.0 E_QETIPMENT/REAGENTS :

ABI 7500/Computer 96-well Reaction Plate

ABI 7500 SDS Software 96-well Reaction Plate Base
Pipettes and Tips Optical Adhesive Covers

Reservoir (opticnal} Centrifuge (optional)
Quantifilerm Human Kit Microcentrifuge Tubes/Strip Tubes
20 pg/m{ Glycogen (optional) PCR-TE
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4.0 PROCEDURE:
4.1 PREPARATION OF DNA STANDARDS:

4.1.1 Label 8 sterile microfuge tubes, or strip tubes A
through H or 1-8.

4.1.2 Dispense 30ut (or adjusted amount according to the kit
QC results: Form 419-0C) of PCR-TE into tube A (std.
1) and 20pt of PCR-TE into tubes B-H (std. 2-8).

4.1.3 Mix the Quantifiler Human DNA Standa g%oroughly by
vortexing 3-5 seconds. Transfer 10 to tube A (Std.

1). Mix the dilution thoroughly@b

4.1.4 Prepare Std. 2-8 via a serlal llutlon by mixing and
subsequent 10p!¢ transfers bes A through H. The
dilution series consists €$ 50 7, 5.56, 1.85,

0.62, 0.21, 0.068, and respectively.

4.2 REACTION PREPARATION: \\0 Q @Q/
o

4.2.1 Determine the n }§$§sa Piés to be quantified
(including, a Osets of DNA standards).

4.2.2 Finish fi % Q%F@T'SOO Load Sheet on the Database

worksheef® te orm:-312=BT}. Print a copy for the
case ﬁé@% Ch 0 the Y7500 Plate Document’ tab and
ens Stion is correct and corresponds to the

é@ S e {Zgzkmatlon Perform a ‘Save As’ of the
Réﬁte Doc Worksheet to disc (e.g. USB drive) for

Qgﬁubsequent ransfer to the ABI 7500. The document must
{g) be saved as a .txt file.

‘g 2.3 Calculate the volume of reaction components needed,
based upon the number of samples to be quantified and
adding 2 or 3 reactions to compensate for loss and
variability due to pipetting. The following are the
volumes needed per reaction.

Quantifiler PCR Reaction Mix 12,511
Quantifiler Human Primer Mix 10.5ut¢

Note: The volume of reaction components necessary to
prepare the Master Mix will be automatically
calculated upon Load Sheet data entry.
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4.2.

4.2,

4.2,

4,

.2.4

4,3 RUNNI

4

%

O

Page 33 of &8

)

<R Turn on the 7500 computer and login with the appropriate

Thaw the primer mix and vortex 3-5 seconds. Pulse-spin
prior to opening the tube. Mix the PCR Reaction Mix by
gently swirling the bottle prior to use.

Place a 96-well reaction plate into a base, being careful
not to touch the top or individual wells. Do not place
the plate directly onto the counter or any surface other
than its base or the ABI 7500 thermal blegk.
‘\O

Prepare the Master Mix by pipetting é&% regquired volumes
of primer and reaction mixes into @ ppropriately sized
microcentrifuge tube or reservoijcp Mix thoroughly and
pulse spin if mixing in a tube{.\@\
Carefully pipet 23ut¢ of %25 CR.Q?Ster Mix into the
bottom of each reaction 1 b sed. ‘Blowing-out’
the pipette is not rg%§@mendg Zgéévoid splashing and/or
bubbles in the well AN QQ

O X

Add 2pt of sampl@gr %\&%d@to the appropriate

reaction well in ard:) to avoid bubbles as much as
possible, (%\ \\Q '
Seal the ‘{%?9 @te with an Optical Adhesive Cover.

Proce@
R

I\QC\;‘HE Rﬁc@% :

user name and password. After the computer has
completely started up, power on the 7500 instrument,
allowing it to warm up at least ~30 seconds. Launch the
ABI 7500 5DS Soitware.

4.3.2 Open the instrument tray by pushing on the tray door.
Place the plate into the tray holder so that well Al is
in the upper-left corner and the notched corner of the
plate is in the upper—-right corner.
4.3.3 Close the instrument tray by gently pushing the right
side of the tray docor.
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4.3.4 In the SDS software, select File>New and choose Absolute
Quantitation for Assay, 96-Well Clear for Container, and
Quantifiler Human Database for Template.

4.3.5 Import the previously saved plate document by selecting
File>Import Sample Set-Up. Browse to locate the saved
.txt file and choose OK.

4.3.6 Review the plate document to ensure the appropriate
detectors and tasks have been applied to each sample.
Change the task for any unused wells to in View>Well
Inspector or by highlighting and douQSé)clicklng on a
well(s). Make any other changes, ag(Necessary. Select
the Instrument tab and review th rmal cycler
conditions [Stage 1: 1 cycle, 9%35 10:00 min.; Stage 2:
40 cycles, 95°C, 00:15 min, 602 1:00 min.; 25p¢ sample
volume; 9600 emulation; Dagz, ollection: Stage 2, Step

2 (60.081:00))]
QO ggoQ

Note: Detectors are cifbte the initial

instrument setb. /o usage Refer to the
Quantifiie L<§ anual (page 2-11) for
detectors 1if needed.

1nstructl QS> Te

4,3.7 Save the pl Qg;%én6:>s a .sds file with the
appropr;a?s plqé} ﬁé,

4.3.8 Unde I e tab, click Start to begin the run.
Wherx t e<sgn completed, proceed to 4.4.
VR

4.4 ANAfgsiS AND REé;%TS
<2§4 1 Open the plate document to be analyzed.

4.4.2 Select Analysis>Analysis Settings and verify the
settings are set as follows: All for Detector, Manual
Ct, 0.200000 for Threshold, Manual Baseline, 3 for
Baseline Start ({(cycle), and 15 for Baseline End {cycle).
Click OK.

4.4.3 Select Analysis>Analyze.

4.4.4 In the Results tab, select the Standard Curve tab and
choose Quantifiler Human as the detector. Review the
data for inconsistencies from the following:
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An R? value of >0.99 indicates a close fit between the
standard curve regression line and the individual Cr
data points of guantification standard reactions.

An R? value of <0.98 needs further analysis of the
standard curve for problems. Refer to the Quantifiler
Kits User’s Manual (page 5-6) for troubleshooting
guidelines.

The slope should fall within the typical slope range of
-2.9 to -3.3. A slope of -3.3 1nd1cate%b 0%
amplification efficiency. ~SS>

4.4.5 Select the Amplification Plot tab%h the Results tab)
and choose either the Quantlfll uman, or the IPC
detector. Ensure the ThreshoMbns set to 0.20 before
proceeding (Note: the thres \gr will be green if the
data has been analyzed a ?3 ed analysis 1is needed)}.
Highlight the sample (s éé in the table to view

the associated plot(s Qb Ragi€§§{ plots for both

detectors for amp11 %s‘ an r inconsistencies.
N
4.4.6 Select the Com <gn\§§g% in the Results tab. The
halogen lamp acement if the dye signal
lines cont appear wavy/unstable and/or 1f
Q§ proaching or has fallen below

the Rox v ue R@
500. 5 % €2( ote: it is important to use the
C

e
same ngﬁl h time.
O o)
4.4.7 Ig @ne@gu§tab, select the Report tab and highlight

sampl f interest to view the results. Review
Qéfhe Oty column to determine the amount of DNA present in
@) each sample. Review the Internal Positive Control (IPC)
< Cp value for each sample. It should fall within a range
of 20-30. If the value is »30 for a particular sample,
there may be an indication of inhibition.

%

4.4.8 Export the report. Within the report tab, select
Tools>Report Settings and check the appropriate boxes to
be displayed in the report and click OK. Print a copy
of the Standard Curve for the batch record. Select
File>Export to export the report (e.g. to USB drive) as
a tab-delimited text file.

4.4.9 Tmport the tab-delimited text file into the 7500 Raw
Data tab of the Database Excel worksheet/template.
Choose the 7500 Results tab and review the imported
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data. Delete any unused wells from the sheet. Adjust
values in the final concentration and ul Sample for
dilution columns. Print a copy of the results sheet for
the batch record.

5.0 COMMENTS:

5.1 Refer to the Quantifiler Kits User’s Manual for specific
thermal cycler conditions, additional user information, and
troubleshooting guidelines. 5

. <
5.2 If the Component Dye signals appear unstaégéband/or Rox
values approach 500, the Halogen Lamp Hlé?' checked
manually to determine if replacement b eded. Place the

Green Calibration Tray in the block. elect Instrument >
Calibrate and set the exposure timeé}o 4096ms, lamp control
to Max, and select Filter A. pshot and observe
results. Expected results sh <§st of red
fluorescence displayed in all Wel k of fluorescence

indicates the need for lam Qbepl » The lamp status
should be checked as well Qéégk'Instrument > Lamp
o

Status/Replacement and<2 w1é§ t ndition

5.3 In order to extend }é? (%g Halogen Lamp, the
instrument shoul f anytime it is not in use.
Lamp life is ape}o , 000 hours.

&b OQ
NS

o“ 0(\0@%0
&) ®)
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BI-316

STR AMPLIFICATION: PP16 HS

1.0 BACKGROUND:

DNA analyses have revolutionized forensic biology. The
advent of PCR allowed scientists to analyze evigi@ntiary
material present in minute guantities and degfaded states.
The identification of forensically 51gnlfldé t STR loci has
allowed scientists to combine the dlscr ation attainable
with the older RFLP technology with th speed and sampling
capabilities of other PCR-based meth %{ogles The
PowerPlex™ 16 HS allows the co- amp 1ca ion of the core
CODIS 13 loci, as well as, Amel 1n d two
pentanucleotide-repeat loci, Pe ta Q:g% nta E.

Butler, J. Forensic DNA Ty‘Qgé ﬁsgb and Technology
Behind STR Markers. 200{2 ess.
PowerPlex™ 16 HS Sngéﬁ'T h iﬁ) Manual

2.0 SCOPE: AK
To provide a %ﬁ?&b 4 for consistent, high quality
ampllflcatiokfb offender database samples ensuring
the genera le PCR product for capillary
electrcp@g§631s an alyses of these STR loci.

3.0 EQUIP@&T /REAGENTS :

Thermocycier

Microcentrifuge

Microcentrifuge tubes and/or reservoir
96 well Reaction plate and base
Pipettes and tips

Foil Seal or Optical Adhesive Cover
Compression pad

PowerPlex™ 16 HS Kit Contents
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4.0 PROCEDURE:

4,1 DNA TEMPLATE:

4.1.1 Based upon the quantity of DNA isolated and its

initial concentration, the scientist should have all
samples at an optimal concentration for amplification
(e.g., 0.1lng/ut). It is also convenient to have all
samples, that are to be amplified at the same time,at
the same concentration if possible for egse in the
preparation of PCR Master Mix and reactd additions.
The maximum amplification volume for‘{@w level or
undetected samples is 4.4p¢ for Powé€rPlex 16 HS,

quarter volume reactions. For 1 r volume samples,
it may be necessary to concentxe}e the sample priocr to
amplification. QD

Q

4.1.2 The amount of DNA templat€§g%d ‘4&0 a guarter volume
amplification reactlon ou E rgeted at ~0.25ng.
4,2 BMPLIFICATION SET-UP: §§>
4.2.1 Thaw the PowerP Sg \;gr Mix, PowerPlex 16 10X

Primer Pair M d 1catlon Grade Water
(optional) a\gga he HotStart kit.

4,2.2 Calcula ﬁ@he\&ol &of reaction components needed

QP

base é@% I er of samples (including extraction
and a (5 controls) to be amplified and adding
1 00 \€§ 1S50s to compensate for loss and

Ké%lablll e to pipetting. Use the ‘Amp.

&orksheet’ ab of the Database Worksheets Template

(Form 312-BI} to automatically calculate necessary
volumes. Print a copy of the completed worksheet for
the batch record. The following is a list of the
'fixed' amounts to be added for a 6.25uf reaction.

PowerPlex HS 5X Master Mix 1.25ut¢

PowerPlex 16 HS 10X Primer Pair Mix Q.6ut
IDNA Template + dHz0 4,4p¢

lpsr FTA extracted samples there is no volume for the
DNA template so 4.4p¢ of dH;O will be added to these
tubes.
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.........

Note: The amount of Reaction Mix added to each sample
is dependent on the volume needed to add the DNA
template.

Prepare the reaction mix by pipetting the required
volumes of 5X master mix, 10X primer mix, and water
{if needed) into an appropriately sized
microcentrifuge tube or reservoir. Mix thoroughly and
pulse-spin i1f using a tube.

Pipet the appropriate amount of reactig ix into each
well of a labeled 96-well reaction plaly The
negative amplification control shou{ébbe the last
sample processed. %Q

appropriate volume of dHzO ecessary

If DNA concentrations were noé<§he same, add

Pipet each DNA sample 1<%g>t<:§§;E opriate well,
h

Use 9947A control DNA lve amplification
control and dH:0 fo \ghe amplification

control. Q 0

Thoroughly sea Q@h ateé;&th an adhesive foill seal.
Use a seal %} ightly seal between and over
each well ,&

Remo égg cﬁ?ﬁ 564 touching only the plate,
Qﬁles to the thermal cycler in the
p2$0 , using the other hand on the door

b.
E@* o
Place a compression pad over the plate and put it into

the thermal cycler. Remove/discard gloves before
exiting the Amp/PostAmp room.

4.3 THERMAL CYCLING PARAMETERS:

4.3.1 After the samples have been placed in the thermal

cycler, turn on the power and select the appropriate
pre-programmed cycling profile.

4.3.1.1 For DNA IQ-extracted and low level FTA-

extracted samples, use 'ppl6HS' with the
following conditions:
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L i

4.3.1.2

\6

Database Bnalytical Methods:
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96°C for 2 minutes,
100%
for
29%
for

to:

30 seconds,
to:
30

ramp
94°C
ramp
60°C
ramp 23% to:

70°C for 45 seconds
for 10 cyecles, then:

seconds

100%
for
29%
for

to:
30 seconds
to:
30 seconds
to:
45 seconds

ramp
9G°C
ramp
60°C
ramp 23%
70°¢C for
for 20 cycles,

\
60°C for 30 mmé{%

4°C soak

\\C)

For FTA-
templ

cona%t

tra

on ehay

thenq§}

then:

égb

@gé&

les {other than low
with the following

used:

962 {{3@ @\g(utes, then:

C @br

ag§$299
60 for

ramp 23%
70°C for
for 10 eycles,

30 seconds,
to:
30 seconds
to:
4% seconds
then:

100%
for
29%
for

to:

30 seconds
to:

30 seconds
to:

45 seconds
then

ramp
90°cC
ramp
60°C
ramp 23%
70°C for
for 17 ecycles,

60°C for 30 minutes,

4°C soak

BI-316

then:
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5.0 AMPL

JFIED DNA PRODUCT:

5.1

5.2

After cycling has concluded remove samples from thermal
cycler. Samples should be run on the Genetic Analyzer as
scon as possible after amplification. Prior to capillary
electrophoresis and/oxr before analysis is completed the
samples may be stored at 4°C. For longer storage periods,
samples should be frozen at -20°C. Amplified product is ONLY
stored in the Amp/PostAmp room. ng

At a point in time after STR analysis is c ‘\leted {i.e.,
data has been reviewed and approved forggaload), the
amplified product will be disposed of in“a bilohazard
container in the amp/post-amp room. . needed, this
container will be sealed and trans directly to the
dishwashing room. The contalner 1 égpﬂaced into a second
biohazard bag, sealed and dlSp<§ <i§> 1KQ other biohazardous
material.

.0 COMMENTS:
COMMENTS QO 0@

6.1

6.4

6.5

Clean surfaces with Bgéshbékmz (gOf bleach scolution or

Dispatch® prior tQED é§>
Wear gloves a @1 %% ’&g/ng amplification set-up.

Mix all g J'\ghly (e.g., vortex) and pulse-spin

them in <§> r to dlspen51ng

If eggggﬁlve eva ratlon is observed following

amp ication, an optical adhesive cover may be used to seal
e?& plate rather than the foll seal.

When using a % volume reaction, the amplification reagents
may be completely absorbed by the 2mm BSD punch, if used for
the FTA extraction method. If this happens, it is
recommended that bul sterile water be added post-
amplification, and thoroughly mixed prior to running on the
genetic analyzer.
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BI-318

STR TYPING: CAPILLARY ELECTROPHORESIS AND DATA ANALYSIS

1.0 BACKGROUND:

Any eukaryotic genome is interspersed with repeate&%@NA sequences
that are typically classified by the length of th@, ore repeat
sequence, and the range of contiguous repeats ﬁb cally seen or
the overall length of the repeat region. @ishort Tandem
Repeat) loci are scattered throughout the me occurring every
10,000 nucleotides or so, and have core Q%géat units of 2-6bp in

length with overall lengths of less th bp.
STR loci examined for human 1dent1 oses were selected
for the following characterlstlcs criminating power
(generally >0.9) with observed V% of >70%, 2} loci on
separate chromosomes to avoil ability to obtaln
robust, guality, reprodu01 ultiplex amplification is
performed, 4) low stutte lon rate and 6) small
allele sizes (<500 bp) cég?bgggi nt of analysis of degraded
sanples.

© O L
By 1997, as the unity-wide forensic science
effort, the fol {Nln C§§%

£§§B loci, all tetranucleotide repeats,
were selected Q} for NDIS, the CODIS {COmbined DNA Index
System} Nat al Da agggz: D351358, THOLl, D21s1l, D18sbl, D5S818,
0138317, 820, D16s5%9, CSF1PO, vWA, D831179, TPOX, FGA. When
all 13 S core locil were examined, the average random match
probagﬁslty was found to be <1 in lxiO12 among unrelated

indi vals, offering the promise of individualization.

In addition to the 13 core CODIS loci, the PowerPlex 16 HS
multipiex includes Amelogenin, a gender identification locus, and
two pentanucleotide repeat STR loci, Penta D and Penta E. STR
typing, with amplified products generated from this kit, separated
by capillary electrophoresis on the 3130 Genetic Analyzer with
data collection and analysis software employed in developing the
genetic profiles, will be used to produce STR profiles from
convicted offender samples for entry into CODIS.
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Butler, J. Forensic DNA Typing: Biology and Technology Behind
S8TR Markers. {(2001) ARcademic Press.

PowerPlex™ 16 HS System Technical Manual
PowerPlex® Matrix Standards, 3100/3130, Technical Bulletin
ABI 3130/3130x]l Genetic Analyzer Getting Started Guide

ABI 3130/3130x!l Genetic Analyzer Mainenance Troubleshooting

and Reference Guide ng
WO
GeneMapper™ ID Software User Guide *&
@
2.0 SCOPE: Qb

profiles from offender DNA databasg(sa

To provide a reliable method for ge ?A% ég STR genetic

O
3.0 EQUIPMENT/REAGENTS: <Z Cb ‘éf\
3130XL Genetic Analyzer zzﬁh a§§>~s§§éctlon Software

GeneMapper™ ID Software
Computers

9700 Thermal Cycler(g b 0
Pipettes and Tips

Benchtop Cooler\Q é

Capillary Arr

96 Well Rea%@z@?t \ﬁd Septa

Buffer Resd&hvo epta

POP4 Pol@;
Genetl nalyzer é;}fer

POWB§§%GX® 16 Kit HS Contents

ex® 16 Matrix Standards
onlzed Formamide

Nanopure Water

4.0 PROCEDURE:
4.1 AMPLIFIED FRAGMENT DETECTION USING THE 3130x1

Note: Prior to using the ABI 3130x1 Genetic Analyzer for
samples, a spectral calibration (matrix standards} must be
run to achieve proper color separation of the dyes used for
the amplification primers, allelic ladders and size
standard. To prepare a matrix, four standards are run
under the same capillary electrophoresis conditions that
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will be used for samples and allelic ladders. Use the 3130
Matrix Standard set, which includes the Fluorescein Matrix,
JOE Matrix, TMR Matrix and CXR Matrix for the blue, green,
yellow and red matrix standards, respectively. This is
performed when necessary due to performance, or after any
instrument maintenance/repair that involves
adjustment/replacement of the CCD camera or laser.

Additionally, a Spatial Calibration must be performed prior
to running any samples. The instrument uses images
collected during the spatial calibration to est#blish a
relaticnship between the signal emitted for eqégbcapillary,
as well as the position where that signal s and is
detected by the CCD camera. This is per ed any time a
capillary is installed or replaced (in temporary
removal of a capillary} or if the lDS {iment is moved,

4.1.1 Turn on the computer, e instrument,
start Data Collectio 225%2 nd wait for green
squares to appear f &t thﬂS on the
service conscle. panQb cessary subfolders
on the left tr (p ne\' Collection. Refer
to the ABI 313 313ﬂg§ tic Analyzers Getting
Started Guid&@iorﬁﬁétii§26 instructions on

instrumen xggt— LQE§ ding creation of
i c results groups, and spatial

instrumen praf c@
calib igggb £§~ in appropriate information in
Ox 1 j{%éﬁa

the ion Log {Form 422B=0C) .

Q§p <§§®n erformed in the opposite order
ata &:tlon software, 3130x1, then
ompute The Data Collection Software must be
P
@ o
(Q closed by choosing ‘Stop All’ and waiting for all
<2{$> red symbols to appear before closing. Never use

the ‘X’ to close while green or yellow symbols
are displayed.

4.1.2 Create a new plate record:

4,1,2.1 for a spectral calibration plate expand
the tree pane of the Data Collection
Software and click ‘Plate Manager,’ under
‘ga3130x1l’. Choose ‘New’, and fill in
the dialog boxes, with ‘Spectral
Calibration’ as the application. Fill in
the applicable dialog boxes on the
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[y

Spectral Calibration Editor as follows
{clicking ‘OK’ when complete to save):

Sample Name:

Priority:

date Spectral

May optionally be changed to a

number <100 for injection priority.

Instrument Protocol 1:

drop down menu

Module Type:

&
RIS
Da':tfze;t D Q/
Run 2263 (& gzi;§§b

S
R D
C;qur %;%ég;gz:

ondltlon bound:

Q%%ﬁ/ condition bound:
{SS C§%hj Secs: 5

4.1.2,2 For a sample plate finish

<
&S

Choose the
Spectral instrument protecol

Ny

PowerPlex 16 specific %@'
protocol settings fo ectral

Calibrations are aqé§gllows:

om the

module and

Spectral
Spect36_ POP4
3

100

800

Spectral

F

36

Matrix Standard
4.0

12.0

filling out the

3130XL Load Sheet on thg database
worksheets template (Form :312-BI).
a copy for the CODIS file.

Print
Choose the

*3130x1 Plate Document’ tab and ensure the
information corresponds to the Load Sheet

information.

Verify the information on

the template is as follows:

Container Type: 96-Well

Application Type:

Database Analytical Methods: BI-318
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\(\Q nsmﬁmerﬁz

<
&S
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GeneMapper: GeneMapper_ Generic Instance

Sample Name:

Allelic Ladder: LADDER (or PP16 LADDER)

Controls: POS f{or (+), etc.], NEG [or (-
), etc.], RB (reagent blank)

Database samples: IDH#E#HEHEHE
{e.qg., ID2001001412}Q§b

Priority: May optionallw(3§ changed to a
number <100 for injectidd priority.

Sample Type: Samplg <éategor1es of
‘Sample’, ‘Alleli adder’, ‘Positive

Control’, or ‘Naé@ Control’ may
optionally beQ@pe@Q &
Results Gxd é}' the apprcpriate

results quup \i) are typically
denoteézby t» yst initials and
shouﬂb t@ha ly pcpulate from the

A Q{

rotocol 1: Enter the

a Enﬁé&e instrument protocol {e.g.,
6€5 ec, PPl6 3 sec, PPl6 10 sec).

é&brPlex 16 specific run module and
otocol settings for sample plates are
as follows:

Module Type: Regular
Template: HIDFragmentAnalysis36 POPA4
Inj. kV: 3

Run Time (seconds) :2000

Protocol Type: Regular
DyeSet: F

Inj.Secs: 3-10

3 secs - Generally produces good
results for Allelic Ladders and
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samples 2.2b5ng {injection times
....... 5 may be adjusted [3-10 seconds
- per analyst's discretion).
5 secs.- Samples <.25ng generally
produce good results.

4.1.2.3 Delete any unused wells. Perform a ‘Save
As’ of the Plate Template Worksheet to
disc {(i.e. USB drive) for subsequent
transfer to the ABI 3130x1. The document
must be saved as a .txt file é%yb
delimited).

4.1.2.4 Import the prev1ously zzgg plate record by
selecting ‘Import’ ‘Plate Manager’
window. Browse to s‘ te the saved .txt
file and choose *?

4.1.2,5 Open the impog%FﬁE£i§§% ecord by
highlightin Jisg ‘Edit’ .
Review th\éb foxm n the GeneMapper
Plate E §E§§§e that it is correct
or mak cha ecessary. Click ‘OK’

whenx@bmgfé&e ave the plate record.
4.1.2.6 T@pe@ er than one run of a sample
\CS) 5{ le injection times), select
Qo E déé da’ﬁ

Ad¥/Bample Run in the GeneMapper
e> itor window. This will add
onal Results Group and Instrument
A 0 é ocol columns to the end of the plate
{S’ cord. These additional runs may be
<Q added at any point in the run, prior to
{S) the last injection, 1f the scientist
<2 notices that a sample would benefit from
re-injection (e.g., repeat because of bad
injection or to vary injection times
[from 3-10 seconds]). Additicnal Results
Groups and Instrument Protocols may also
be filled in on the original Load Sheet
template prior to importing.

4.1.3 In the manual control window, the scientist may
choose to set the oven to 60°C so that it will be
ready to run. Choose Oven in the ‘Send Defined
Command for’ drop down menu box. In the ‘Command
Name’ box, choose Turn On/Off oven, with a
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“Walue’ of On, and click ‘Send Command’. Next,
in the ‘Command Name’ box, choose Set oven
temperature, with a ‘Value’ of 60.0 and click
‘Send command’. Note: once the oven has been
turned on and the temperature set, the oven will
only preheat for 45 minutes before shutting
itself off.

4.1.4 Prepare samples for capillary electrophoresis:

4.1.4.1 For amplified products (includéng
controls), typically 1pf-1, rxn is
added to 10uf of ILS Masggx Mix {(made by
adding 0.5p¢ ILS600 si tandard/sample,
9.5n¢ deionized formam e/sample and
adding quantities fo@/N+2 in Master) that
has been dlspense to the wells of a
pre-laheled pla Allelic Ladders
add 1luf{ Ladd aster Mix. Note:
The master Qib ered by adding
0.25p¢, & %‘ @i? ILS600 size
standax gib Ton §§> ut, or 9.25u¢

deioni?»éd f Q% respectively if TLS

peah&@&re\@o
4.1.4.2 Mgarl m@igg are diluted 1:10 in
QO a q@ /<k{ 5u¢ of each matrix dye
) fng§m é%ds then added to 480pt¢ of
\§> <§%1> d formamide (without size
é} \:§}st rd). Load 25 pt¢ of the fragment

~§ into each of 16 wells on the pre-

{S’ beled plate, which will include each of
(fb the 16 capillaries (e.g. wells Al through
) H1 and A2 through H2).

<2K
4.1.5 Folleowing sample addition, place a plate septa on

the plate and heat denature for ~3 minutes at
95°C., Immediately chill in benchtop cooler (or
on ice) for 23 minutes (perform on all sample
types - ladders, matrix, controls and samples).
Note: the plate septa may be cut to cover only
those well columns being used on smaller plate
runs.

4.1.6 Place the sample plate into the plate base and
secure the plate retainer clip on top, making
sure that no gray is visible through the holes.
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4.1.7 Place the plate assembly in the instrument in

either position A, or position B and close the
doors. The plate map on the ‘Plate View’ window,
under ‘Run Scheduler’ will turn yellow when the
plate is in place and has been detected by the
instrument. Note: the 3130xl will accommodate
two plates per run.

4.1.8 Prior to running the pliate, confirm that dye set

F is selected and the correct active galibration
for dye set F is set in spectral vi

A\

4.1.9 Locate the plate record in the Qgtate View’

window and highlight it by cliaKing on it once.
With the plate record highlig¥ted, click the
appropriate plate map ({(po ion A or positicn B)

to link the plate to thagb fic record. The
plate map will turn izg} to green when it
he correct

is successfully llnfé
scheduling of th un View’ window
Select a run a &;& the corresponding
wells hlghllgh d 1n»{h ate diagram are
correct fox‘t‘ t x\ e adjustments to the

plate rec%\‘ @ Y.

4,.1.10 Click S;/Enstrument arrow button in
the 1b q\t rt the run. Monitor
e by observing the run, view,
321 llaries viewer window. Each
nije et of sixteen samples) will take ~45

Q‘OQ

igihlnutes Note: to run a duplicate plate record,

the plate may need to be unlinked prior to
linking the duplicated recerd. This is done by
highlighting the currently linked plate record
and clicking ‘*unlink’.

4,1.11 After completion of the spectral calibration run,

open the ‘Spectral Viewer’ window to evaluate the
spectral and set the active calibration. Confirm
that Dye Set F is selected. Click on individual
wells in the plate diagram to see results for
each of the sixteen capillaries. For each
capillary, verify that four peaks are present in
the spectral profile (upper pane), that the order
of the peaks are, from left to right, blue-green-
yvellow-red, and that the peaks are reqular in
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appearance. Next verify that four peaks are
present in the raw data profile (lower pane),
that the order of the peaks are, from left to
right, red-yellow-green-blue, and that the peak
heights are above 750RFU (1,000-4,000 RFU is
ideal). If at least 12 capillaries pass, then
the calibration should be saved and set as the
active calibration.

Note: A minimum of 12 of the 16 capillaries must
pass in order to accept a spectral caldbration.
A passing capillary will be colored een in the
plate diagram. Additionally, ciESSXary status

may be viewed in the ‘Event Lo nder
‘Instrument Status’. Rerun thes/spectral
calibration as necessary untea? at least 12
capillaries pass. {}
@
4.1.12 After completion of gggh fllllng out
the 313021 Injectlo C}‘ 2B=-QC)

NS @
4.2 DATA ANALYSIS: GENEMQPER@\@)% C}Dx
4.2.1 Data anal&;@g éﬂ__ formed on the instrument

computers Qgé he run folder {inciuding
o

the 3 A{ rd) to an analysis computer
usi poégébl SB drive. After analysis and

T ete, a copy of the run folder and
Eﬁpje will be stored on an analysis
comp é@xll Ch/DVD archiving has been
QD omplet The Run Folder on the instrument
C§Q computer may be deleted at this point.
<
<2 Note: prior to data analysis, the appropriate

panels and bins must be imported into GeneMapper®
ID. Additionally, previously run Macintosh data
must first be converted to PC files using the
‘Mac to Win’ conversion program.

4.2.2 Set up the analysis methods for GMID analysis as
follows (analysis methods are created and stored
in the ‘Analysis Methods’ tab in ‘GeneMapper
Manager’}):
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‘General’Tab: Name the analysis method sco that it
reflects what the method is (e.g. 3130PPl6-
150RFT) .

‘Allele’ Tab: Choose the appropriate bin set.
Choose ‘Use marker-specific stutter ratio if
available’, and ensure ‘minus stutter distances’
are from 3.25 to 4.75 for tetra and from 4.25 to
5.75 for penta. All others should be 0.

‘Peak Detector’ Tab: Advanced Peak Defection
Algorithm, partial sizing (80-550 e% light
smoothing, Local Southern size ¢ £§1ng method
with baseline window of 51 pts 1n peak half
width = 2, polynomial degree q? peak window
size = 15, and slope thresh% s = 0,

Analysis range may be sa§b <§%ther full or

partial and is emplru<%£p e a&glned for each

run and/or 1nstrume Wi;h irig partial range,

the start and stoQ$b01nQ§ etermined by a
OYa

review of the cosing points that

will not lnclugz thgk r peaks but will cover
the size ra%?& ?é;éb ?S) 00 bases.

Peak Ampfgaud\éégﬁgi lds will depend on sample

150 rfu threshold in all

quall
;3§?> th hold may be raised in Blue,

for Allelic Ladders if

\:§}y u threshold may be lowered to 100
4%1 nalyst s discretion (see 4,3.2 RFU
is' hreshold). Peaks below 100 rfu are deemed
inconclusive.

@Q
<2 ‘Peak Quality’ Tab: The minimum peak height ratio
for Heterozygote Balance should be set at 0.5 for
database (CODIS) samples. Set the max peak width
to 1.5 bp and pull-up ratio to 0.05. The signal
level and allele number may be set according to
analyst preference and sample type.

‘Quality Flags’ Tab: The quality flags are only
used as a tool to aid in data analysis and review
(i.e. to assist in calling attention to potential
artifacts or data guality concerns). These flag
settings may be adjusted according to analyst
preference and sample quality.
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!

4.2.3 Create and store a size standard for GMID
analysis, under the ‘Size Standards’ tab in
‘GeneMapper Manager’. Name the size standard so
that it reflects what the standard is {(e.qg.
ILS600 80~600).

Data analysis will be performed using the ‘Basic
or Advanced’ size standard. The size standard
consists of the following peaks: 60, 80, 1G0,
120, 140, 1eC, 180, 200, 225, 250, 27} 300, 325,
350, 375, 4060, 425, 450, 475, 500,. , and 600
{the 60 and 600 peaks may be opt;eh lly defined
by the analyst). qb

4.2.4 Create a GeneMapper® ID Proiggi:

4.2.4.1 From the GMID ma@i @, select File/Add

Samples to p g&é? Lq;light the
f §§i the pop-up

approprlateq§
window a 1c o List’. Once the

run foig e oplied to the column
on the lg2§§b<:;?§l ‘Add’ to populate the

pProj samples in the run

%‘
4.2 .4 n Zﬁes taple, for each sample,

D s sample type, analysis method,
\§> §§%1 \Nénd size standard from the pull-
1sts Ladders must be assigned the
le type of ‘Allelic Ladder’ for the
\ é)ﬁly31s to occur. In order to use the
(5b control concordance guality flag, all
{S) controls must be marked appropriately as
<2 either ‘Positive Control’, or ‘Negative
Control’. All others may be marked as
‘Samplie’

4.2.4.3 Save the project as the date MMDDYY,
followed by CODIS (and any other
descriptors that may be necessary).
Note: the analyzed project will be
exported to the run folder at the
completion of analysis/review.

4.2.4.4 Analyze the samples by clicking the green
Analyze button. If the project has not
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already been saved, a prompt will appear
to enter a project name before analysis
will commence.

4.2.5 BEvaluate GeneMapper® ID Data:

4,2.5.1 The Raw Data may be reviewed to determine

analysis start/stop points, or to
identify baseline problems, off-scale
data, excessive 'spikes' or other
ancmalies that may interfere ®wath data
analysis and require re- inl\ ion or
other corrective measuresﬁs Expand the
run folder located in Hg,nav1gatlon pane

on the left, Highlight/the sample(s) of
interest to view thé\dssociated sample
information, raw a and EPT data.

Minimize or hlg he run folder to
return to th Q§31§st window.

4.2.5.2 Check the»(§8 ﬁégzuallty) for all

samples c> g are indicates that
the sa ed the sizing criteria
and ngd n@} Y:% anually examined.
E ﬂ» standard of each sample
h d/or red ‘8Q’ to confirm
gnment of fragment sizes.
Q> Jé?? the sample(s) of interest and
\6 \bhe Size Match Editor button. If

3
@ S

Q‘OQ

Database Analytical Methods:
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ary, adjust the peak assignments by
t clicking on a peak and deleting,
ding, and/or c¢hanging values. If all
peaks are correctly labeled bhut the
quality score is below 1.0 (may be
checked by choosing Tools/Check Sizing
Quality), click the ‘Override SQ’ button
to set the S0 to 1.0. Once all edits
have heen made, click ‘OK’' tc save the
changes and close the Size Match Editor
(clicking ‘Apply’ saves the changes but
leaves the S8ize Match Editor open).
These samples are ready for reanalysis in
the project window.

Note: Data may still be deemed acceptable
without the ILS 60 and/or 600 bp peaks
present. If additional peaks are
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assigned because of bleed-through of TMR
peaks (typically Amelogenin peaks), the

scientist may choose an Analysis Method,
with an increased rfu threshold for the

red channel toc prevent these peaks from

being detected, if desired.

4,2,5,3 Examine the blue, green, and vyellow
allelic ladders. Check that correct
allelic assignments were made.

)

Note: GMID automatically aw ges all
valid ladders in a run fQ€S§enotyping.
Genotypes are assigned-d¥ comparing the
sizings of unknown al es from samples
with the sizings of‘éﬁown alleles
contalned within averaged allelic
ladders of each A ladder(s) may
be omitted f (y by deleting it
from the ma ro?ib dow prior to

analysis. \C) @
4.2.5.4 Data m§2 bexd Qﬁaii? d in various
o]

combggﬁtlbsé lors and/or tables to
%;;gt asgfzhrough, spilkes, stutter,
- l variants, etc. Sample
Y} from the ‘Samplies’
Dt aé&w 'é@w, allows all loci in a given
x?§> §§h1> to be viewed simultaneously.
NP

mple Plots view from the
Xé\ Ggéhotypes tab/window; however, allows
Qé‘ ci to be viewed individually (more than
(Q one locus can be viewed at the same time
<2<$) by adjusting the number of panes
displayed).

4.2.5.5 GeneMapper® ID includes a series of
quality flags (PQVs) to alert the analyst
of potential sample quality concerns. A
green square indicates that sample data
has passed all of the quality checks, but
yellow or red indicate that the data has
a problem with one or more of the quality
checks. A yellow or red flag does not
necessarily mean that the data is bad or
unusable and the flags are not to be
relied on solely. The analyst may choose
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to use the PQVs, in combination with
manual data examination to aid in the
identification of bhleed-through, spikes,
stutter, off-ladder variants, -A, etc.
Once the data has been evaluated and
deemed acceptable, the analyst may choose
to override the yellow or red Genotype
Quality (GQ) flag by right clicking on
the flag in the Genotypes Sample Plots
view. Note: overriding the GQ flag will
cause all other flags to turagﬁrom the
original color to gray. ‘63

4.2.5.6 All negative controls é? luding reagent
blanks) should be e%ES ed to verify that

each displays a relatfvely flat baseline
in blue, green andcs%l oW .

4.2.5,7 Review all sa Qe (igc uding positive
controls) f %;b isted
‘artifac (bandq§v e: peak height and
shape, &by 1x§’ &g& and individual
sample rof&v ompare each sample
w1th ek3§;hadder(s) and examine
%‘ ff—@ad or microvariants, signals

o’ low to be genotyped and

Y>'s§<§3 6K f genotypes to stutter peaks
ég} é%?peaks that may have been
(éab (ékfed as 'stutter', etc.

\» 3;3 &S%halyze individual samples with

A 4

erent Analysis Methods, as necessary
if the rfu cut-off will need to be
changed.

4,2.5.9 Edit peaks as necessary, by right
clicking on the peak label and selecting
‘add allele’, ‘delete allele’ or ‘rename
allele’. The allele should be labeled,
at minimum with the allele call, however
the analyst may select up to four allele
labels, including peak height and size,
from the ‘Plot Settings Editor’ window.
Note: labels added to artifact peaks,
such as spike, pull-up, etc. will appear
in the Genotypes table as an additional
allele.
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4.2.5,10 Samples demonstrating an off-ladder (<
or > smallest or largest ladder allele,
respectively), tri-allele, or
microvariant (alleles with incomplete
repeats}) allele(s) should be re-analyzed
for verification. Microvariants will be
labeled and reported as "X.Y" {where X is
the number of complete repeats and Y is
the number of basepairs of the incomplete
repeat). Off-ladder will be ported as
> or < the largest or smallggﬁbladder
allele, respectively. é& the
nomenclature for uploa NDIS may
necessitate a change 1 allele
designation. Q}

4.2.5,11 GMID automatic G%, s off-scale
(camera satu . This data may
still be ac ' iz limited to a
few or a’ q%b d the overall data
for th good quality (see
4.4, 2 )

4.2.5.12 ésgbrt e/genotypes table to
e it in the run fclder. The

Q; e printed for the CODIS file.
eg} T should also be exported as a
e for CODIS import. To create a
\:§> c ile, the specimen category must be
igned and the export fields set in the
{S’ ODIS Export Manager’ under tools in the
main menu,

Q‘OQ
4.3 STR INTERPRETATION GUIDELINES
4.3.1 CONTROLS

4.3.1.1 The purpose of a REAGENT BLANK (RB) is
to determine 1f the reagents used for
DNA extraction/isclation were
contaminated with human DNA and as a
method for monitoring facility
decontamination. In GeneMapper®, ID
peaks above threshold should only
appear in the CXR (red dye) lane,
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J

corresponding to the ILS600 size
standard. Electropherograms for the
blue, green and yellow dyes should show
a relatively flat baseline throughout
the range (discounting primer signal,
fluorescent 'spikes' or CXR bleed-
through). If detectable signal, with
characteristic 'peak' shape is visible
in the electropherogram of a reagent
blank and does not disappear upon re-
injection, results for all sociated
samples may be deemed ing lusive
(close examination atkégs}fu is
performed on all sa to examine for
presence of any allq§28 seen in the
RB). Data may be @demed acceptable if
contamination i c"7isolated' to the RB.
The reagent bké@k uld be treated the
same as th Q> n&gntrated DNA

sample ind m\c Qei me and amount
in t:<%ytime/amount, and

ampllf

anal &th& Y Additionally, the
gzt plEnk A1 be reamplified with

saﬂé&es\@' MNfe set if any of the

&@b ng 5 conditions are more
Genafes

an the original.
e

g§\ @e prpose of the POSITIVE
Cnm

\\ (b ICATION CONTROL {9947A DNA
s\ \)(\ lied with the PP16 HS kit) is to
sess the amplification process,
QS' C)ensurlng that adequate sample amplified
(Q simultaneously would produce an
{S) appropriate signal. All expected
<2 alleles (see below) must be detected,
using standard parameters or all of the
samples associated with amplification
may be deemed inconclusive. Data may
be deemed acceptable if all alleles are
present (though some are below 150-rfu
threshold}) AND the other positive
control (Extraction Control) appears as
expected (i.e. the problem is confined
to the 9947A sample).
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LOCUS
D351358
D21811
Penta E
D138317
D165539
Penta D
vWA
TPOX

4.3.1.3

e§<§\

GENOTYPE LOCUS GENOTYPE
14,15 THO1 8,9.3
30,30 D18S51 15,19
12,13 D5S818 11,11
11,11 D75820 16,11
11,12 CSFLPO 10,12
12,412 AMELOGENIN X, X
17,18 D8S1179 13,13
8,8 FGA 03,24

@6

O
The purpose of the NE%@&IVE
i

AMPLIFICATION CONTR is to determine
if any human DNA gertamination occurred

in the process c@} Slification set-up

(or beyond th and as another
method of rr? QQ &Clllty

decontami e GeneMapper® 1D
electro ro aks above

thres (3 %h{éb appear in the CXR

(red orrespondlng to the
ILS\'@O &&e &dard

qggactrép ams for the blue, green
& yes should show a

flat baseline throughout the
iscounting primer signal,
{é}éscent 'spikes' or CXR bleed-

If detectable signal, with

N
" 0 aracterlstlc 'peak' shape, is visible
S <>1n the electropherogram of a negative

&S

Database Analytical Methods:
Page 58 of €8

amplification contrel and does not
disappear upon re-injection, results
for all of the samples associated with
that amplification will be examined for
the presence of the same peak(s).

If extraneous peaks appear only in this
control, the data for other samples
assoclated with that amplification need
not be deemed inconclusive. This
occurrence should be documented and the
scientist's determination {and basis

for it) documented in the note packet.
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4.3.1.4 The purpose of an EXTRACTION CONTROL

4.3.2 RFU THRESHOLD: .\Q® Q\' Q/é

sample is primarily to assess correct
genotyping, however, it does take
measure of all of the steps in the
analytical process from extraction
through allele designation. The
extraction controls consist of
previously typed buccal samples on FTA
cards prepared in batches. An
extraction control must be run on every
sample plate. The reviewingGscientist
will complete an Extractd Control
Check Form (Fofmf212'B§¢SYor verifying
correct genotype (s) @ copy of this
form will be included/in each CODIS
Data file. FailureJof the extraction
control, 1if iso ed to that sample,
will not deemwé%h fQ amples

)

1nconclu81vQ C) &
QS

4.3.2.1 For éaDIS Q% r database samples, a
mlng%umwgf fu should be achieved
tance. If necessary, do

S
&

Q"’@
©

5

\Bo@n

C)(increase DNA template), or re-

QB @nﬁe process as follows: repeat

{changing injecticn time; 3-
2?? ds allowable range), or perform
lysis (i.e., changing amount of
aﬁy ified product added for fragment
alysis), or re-amplification

extraction.

<2 4.3.2.2 Peaks below the analysis threshold

{(based on data obtained and
signal/baseline) will not be
interpreted but should be noted as
being present in the notes (eg. on the
table of results).

4.3.2.3 Peaks marked as off-scale in GeneMapper®

Database Analytical Methods: BI-
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ID (indicating camera saturation} will
not be interpreted if multiple peaks

are affected and if it causes excessive
artifacts (e.g. split peaks, increased
stutter, pull-up, etc.} which interfere
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with data interpretation ({see

_____ S 4.2.5.11y. If the overall quality of

’ the data is not acceptable, the sample

must be diluted, re-injected (3-10
seconds), reanalyzed {(decrease the
amount of amplified product added) or
re-amplified {(decrease DNA template) as
deemed appropriate by the scientist.

4.3.2.4 Multiplex amplification kits are
designed so that heterozyg loci in
single-source samples gen g?gily
demonstrate relatively \1anced peak
heights {[typically a%g% peak height
ratio (phr)]. Som mples, although
single-source, may; JNat times demonstrate
greater 1mbala25€~du to degradation,
stochastic e rimer binding site
mutations, €§% 1 amplification,
etc. Pea 1 os for these loci
(<50% p@b é’at %se samples) will be

f§§%er

flag@@ln Gan 1D,

4.3.3 EXTRA PEA %N\QI@E

4.3.3, 1 CR flcatlon of STR loci typically
Y}» a2 minor product peak one core
e§} Q&p a nlt shorter than the main

x\ !9 e peak (n-4 for tetranucleotide
@) \:§> 1 and n-5 for pentanucleotide loci).
*é\ C) is minor peak is referred to as the
\ stutter peak. Percent stutter
(Q generally increases with allele length
<$> and does not change significantly with
<2 the quantity of input DNA (peak heights
within ~150-4500 RFU}. The measurement
of percent stutter may ke unnaturally
high for main peaks that are off-scale
or due to problems with matrix
performance and can be corrected by
diluting (or reamplifying less DNA) the
sample and/or applying a new matrix.
Locl stutter values are listed in
Appendix A of the Biology Quality
Manual to assess potential contribution
to peaks in stutter positions. N+4
stutter may also be seen on occasion.
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4.3.3.2 Electronic or fluorescent spikes arec
random events that produce generally
splke-shaped peaks in most or all dye
celors at the same location (eguivalent
bp size) within a single injection.
Peak heights usually vary between dye
colors for a given spike. These
anomalies are generally not
reproducible and will typically be
eliminated upon reinjection® If the
spike is above the analy anthreshold
and falls within an al c range that
could interfere with her computer
analysis or scienti s analysis, the
scientist will lap®¥ the spike in the
GeneMapper® ID s ware so that it
appears on the(pr

electropher@@ @O &

4,3.3.3 Dye b Qb aQ§ lies that
typigé() oqgﬁr the same approximate
ple injections and do

locatdon xgbm
nox» 1wa§é pear upon reinjection.
y look like broad or

Qersggd aks and may occur in a

r or multiple colors at the
é$> rox1mate location but can vary
\ Ooln%&;ht The blob should be labeled
é} \:§> d%) e electropherogram (in GMID) if it
XS\ <%hlls within a diagnostic region and is
\ C)of

significant size to potentially
interfere with analysis.

R
<2 4.3,.3.4 Bleed-through or pull-up peaks are a

result of the matrix not correcting for
all of the spectral overlap (most
common with the PowerPlex 16 HS kit
from yellow into red) and may be
increased due to off-scale peaks.
These pull-up peaks are in the same
location (same bp size) as peaks in
another color(s) and are easily
recognized. The presence of bleed-
through should be labeled on the
corresponding electropherogram (in
GMID) if it falls within a diagnostic
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region and is of significant size to
potentially interfere with analysis.

If excessive bleed-through occurs in a
color other than red, and is not due to
off-scale data, a new matrix may be
used at the analyst’s discretion to
correct for the problem.

4.3.3.5 Tag Polymerase can catalyze the
addition of a single nucleotide
{(predominantly adenosine) téspthe 3’
ends of double stranded PQ&Dproduct,
resuiting in product o \base pair
longer than the actual@Zitarget sequence
(+A) . Amplificationparameters include
a final extension.{¥me, so that the
reaction is dri to full A addition
(i.e. all prodéé A}. Split-peaks

may occure%% gzgy t of incomplete A

addition a single aliele
repres %§ aks one base pair
apart QQ% This can occur when
plate DNA is too great
le)., In this instance,
to add the A nucleotide
1 e amount of product

T 1n the time allotted. These
6(0. é‘m l%& will typically contain off-

data as well. Split peaks can be

{> viated by incubating samples at 60°C
\:> r an additional 45 minutes, focllowed
\ C)by dilution prior to reinjection. It
<Q may be necessary to re-amplify the
{S) sample with less template DNA.

%

4.3.4 MIXTURES

4.3.4.1 If, after the elimination of possible
stutter and/or bleed-through, a profile
shows at least 3 peaks at 2 or more
loci, this is strong evidence of a
mixture.

4.3,4.2 Loci that demonstrate only two alleles
but have a heterozygous ratio of <50%
may alsoc be indicative of a mixture.
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However, if data are obtained from
multiple loci, a scientist should
expect to see this or other mixture
indications (> 2 alleles) at additional
loci.

4.3.4.3 Samples showing evidence of a mixture
are to be deemed inconclusive, as
cffender database samples should be
from a single source. An effort should
be made to determine the s ce of the
contamination, if possibl€jyand to
determine if other samgé& may be

affected. qga

3.0 Comments:

5.1 The 310 POP4 Polymer and t%%g]ﬁ‘gﬁl&xl POP4 Polymer

are different and are no Qéslnterchangeably
5.2 The 3130xl Data Colﬁz(Sﬁon Néée does not allow the

entry cof spaces or she&v les, sample names,

etc, An underscox\ mu b ed in place of spaces

when entering C%® @on@
5.3 Low level q§§3 ma?Qt 6§~ few peaks below 50 RFU) may
%/ith the Bi i

be seen pe@y Biomek 3000 extraction.
The co ég%.aégb be disregarded if it is isolated
we@AS on the plate, all peaks are below

to onlgy S§§}
, an Gﬁ%}neous peaks do not interfere with

a calling/in the samples.

5<é{$3 diticonally, low level carry-over may be seen

occasionally on the 3130xl. The carryover may also be
disregarded in samples and negative controls, so long
as the extraneous peaks are low level, do not
interfere with allele calling, and the peaks can be
attributed to the previously injected sample in the
corresponding capillary.
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BI-400

DRIFTCON FFC: TEMPERATURE VERIFICATION

1.0 BACKGROUND:

Successful DNA amplification is dependent on cons%ﬁtent
thermal cycling parameters and achieving prope(b eating and
cooling to facilitate the various steps nece ry for PCR.

It is necessary to employ a method of moni Qgéhg the thermal

cycler performance and verify that the CO ct temperature
has been achieved in order to have con g} nce in the
amplification process. A variety of perature probes have
been developed to test the temperat pecific wells
within the different thermal CYC<§ nts. However,
most of these have proven to be time consuming,

instruments. The Driftcon test multiple
temperatures within a sho pe Qb time and can be used on
the thermal cyclers, asxghll\éé time instruments.

X
Driftcon Operations %nus‘\& GV%SQOD 1.1

O O
Driftcon Quick 8@ € \O\@ars&on 1.4

2.0 SCOPE: ‘\\)(\ )

To provaggég rellabqa method for verifying the performance of
laboratg y thermal cyclers, to include real-time PCR
ins IK nts

and not amenable to testlnggggg time PCR

3.0 EQUIPMENT/REAGENTS:

Computer with Driftcon Software
Driftcon Hardware Module and Cables
Driftcon FFC Fixture

Driftcon Smart Card

ABI 7500 FFC Adaptor

Cork Leveler
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4.0 PROCEDURE:

4.1

%

Database Analytical Methods: BI-400
Page 65 of 68

9700 THERMAL CYCLER VERIFICATION

4.1.1 Set up the Driftcon by connecting the hardware
module to the computer and FFC fixture/probe plate
with the provided cables.

4.1.2 Insert the smart card into the Driftq@%;hardware
module until it stops. O
R\

4.1.3 Turn on the Driftcon computer. Qsén the Driftcon
Software and login with the a é%%priate user name

and password. Q}
4,1.4 Turn on the 9700, place QS@ fixture into the plate
with the cable facing &3, sQéect/start the
the 9700 1id as

‘Driftcon’ protocol., Do CQ%Q
it will damage thQQg} twéé' oid the warranty.
. O @D .
4.1.5 In the Dr1ftcoﬁ<%ofb%§me oose the instrument to

be tested. 3@?&he¢§is instruments does not
appear aut ic&}ly ick start and follow the

wizard pr taQSD
| O .O
4.1.6 Choo he(ﬁrlf n default protocel and make sure
thg\ ep (Baqs§Vﬁhose in the 9700 protocol. Leave
t h&ﬁgsgt ressure, and temperature blank.
nter gﬁﬁbas nezeded (these will appear on the
1 .
6\ nal re t)

{F§27 Start the test by clicking the check mark in the
lower right corner. Make sure the 9700 has heated
completely and the protocol started before
starting the test. The protocol will complete in
~25 min.

4.1.8 The analyst need not be present once the test has
started; however, additional views/information are
available during the run by pressing the Fé key
for a surface view (heat dispersment), F/7 for
measurement values (shown in real time), and F8
for measurement locations (probe wells).
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4.1.9 Once the run has completed, print the report and
place it in the QC binder. Connect to the printer
as follows:

. Right click My Computer’

. Choose ‘Manage’>‘Device Manager’

. Select ‘Network Adaptors’

. Double click ‘Intel(R) PRO/Wireless LAN 2100 3A
Mini PCI Adaptor’ '

. Open the ‘Wireless Network’ tab

. Click the ‘Security’ button and %Eggbe the Data

a0 T

D

Encryption to 64 bit from the dre wn menu
g. Ensure that the ssid is Linksyac&
h. Click ‘OK’ and close all winé%@s
4.2 7500 REAL-TIME INSTRUMENT VERIFIc:p%fe‘N

4.2,1 Set up the Driftcon by cd&gec g the hardware

module to the compute d ﬁ(sture/probe plate
with the provided ca}@es ",
R

4.2.2 Insert the smar @rd .@:0@ Driftcon hardware

module until 1t to

4.2.3 Turn on t \@Ilfﬁbon<§2 uter. Open the Driftcon
Software a the appropriate user name

and pagegrq\.s
4.2.4 ;:{r\é tﬁég \Gggomputer, login with the
@.‘5

er name and password, and open the

{@O 6 ware.

4. {f@ Turn on the 7500, Remove the tray from the plate
loader and replace it with the FFC adaptor. Place
<2 the fixture into the adaptor with the cable facing
out. Place the cork leveler on top of the fixture
and close the plate loader,

4.2.6 In the 7500 8DS scftware, choose File > New and
select Absoclute Quantitation for Assay, 96-Well
Clear for Container, and Driftecon for Template,

4.2.1 Save the plate document as a .sds file with the
appropriate plate name and open the Instrument
tab.
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4.2,8 In the Driftcon software, choose the instrument to
be tested. If the list of instruments does not
appear automatically, click start and follow the
wizard prompts.

4.2.9 Choose the Driftcon default protocol and make sure
the steps match those in the 7500 protocol. Leave
the humidity, pressure, and temperature blank.
Enter notes as needed (these will appear on the
final report).

9

4.2.105tart the 7500 run and Driftcon tes QDStart the
test by clicking the check mark 1 <Qhe lower right
corner. Make sure the 7500 ha &bated completely
and the protoccl started befo %E%tartlng the test.

The protocol will complete 25 min.

4.2.11The analyst need not be c£§\once the test has
started; however, addi /information are
avallable during the ng the F6 key
for a surface vie eauégl ment), F7 for
measurement wval eal time), and F8
for measurement nejibrobe wells) .

4.2.120nce the %g$2has g§§;ed print the report and
place it 1 i¥der. Connect to the printer
as feol Q/
R\Q? c@\ﬁy Computer’
b ho age’ >‘Device Manager’
x\\:§.Sei t <&btwork Adaptors’
. Doublendlick ‘Intel{R) PRO/Wireless LAN 2100 32
Mini PCI Adaptor’
. Open the ‘Wireless Network’ tab
. Click the ‘Security’ button and change the Data
Encryption to 64 bit from the dropdown menu
g. Ensure that the ssid is Linksys
h. Click ‘OK’ and close all windows

@Q

= (D

%

4.0 Comments

4.1 The second page of the report contains information
regarding the number of measurements for each probe.
The number should be approximately double the protocol
time. If significantly higher or lower, the
instrument may be heating too slowly or too guickly.
The percentage should be 100% for each probe. 1If a

Revision 10
Datakbase Analytical Methods: BI-400 11/29/10
Page 67 of 68 Issuing Authority: Quality HManager




the probe may not have

percentage is lower than 100%,
Adjust the

been in the well and measurements missed.
probes and run the protocol again.

5.2 Pass/better than specifications/fail data may be found
beginning on page four, for each temperature. The
measured value, along with the target specifications

are shown in this section.
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